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Report Writer 
 

Report Writer is an add-on module of the School Accounting System and is used to create custom 
reports for your school district.  Reports can be easily created for a detailed or summary format and can 
include the data from any module of the School Accounting System.  With the Report Writer module, the 
user can define how the information is sorted and what records (items) to include on the report.  
Standard reports can also be copied within the Report Writer module and then modified to fit the needs 
of the district.  
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Available Help 
 
Help File 
The School Accounting System (including the Report Writer module) features a Help File that includes a 
table of contents, a topical index, a search option, and context-sensitive help.  To open the Help File, 
select the Help menu from any screen and then select School Accounting System Help.  To then 
access the table of contents, click the Contents tab located in the upper left-hand corner of the screen; 
to use the topical index, click the Index tab; or to complete a search for specific information, click the 
Search tab. 
 
The context-sensitive help provides help text related to a specific field in the data entry and 
maintenance screens of the School Accounting System and its add-on modules.  To access the context-
sensitive help, place the cursor on the desired field and then press the F1 key (or right-click in a field 
and select What’s This?). 
  
To print a specific topic in the Help File, bring up the desired topic and then click the Print button 
located at the top of this screen. 
 
Web Page 
Access Software Unlimited, Inc.’s web site at www.su-inc.com, and to view the Knowledge Base 
containing Frequently Asked Questions (FAQs) and Training Tidbits, click the Knowledge Base link 
under the Help & Support section on any of the main screens in the School Accounting System. 
 
Customer Support Help Line 
The Customer Support Help Line is a toll-free number available to our customers from 8 a.m. to 5 p.m. 
Central Time, Monday through Friday.  The annual maintenance fee for the software includes help line 
assistance for questions related to the School Accounting System and the add-on modules your 
organization has licensed.  To reach our Customer Support Help Line, call 800.756.0035, Ext. 2, or 
utilize the Create a Support Request feature in the software.  If calling, be ready to give the receptionist 
your Name, School District, Customer ID, and a brief message regarding the problem.  After calling or 
creating a support request, one of our Certified Customer Support Representatives will call you back to 
assist with problem resolution.  
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Create a Support Request 
 

The Create a Support Request feature allows a user to request assistance from Customer Support for 
help with a question or issue.  Once a request has been submitted, a Customer Support Representative 
will contact you for assistance. 
 
Creating a Support Request: 
1. From the main School Accounting System screen or a module's main screen, 

click the Request Support icon (see Diagram A) in the lower right-hand 
corner of the screen, or click the Create a Support Request link under the 
Help & Support section. 

2. At the Create a Support Request screen, the customer ID number assigned to your organization by 
Software Unlimited, Inc. displays in the Customer Number field and cannot be changed. 

3. In the Name field, enter the name of the user at your organization that should be contacted for 
assistance, or click the down-arrow button to select the correct one. 
Note:  Only the users we have listed in our records for your organization are able to be entered into 
the Name field; if your name is not listed, click the Cancel button and contact Customer Support. 

4. Enter your question or a description of the issue in the Comment/Question field.  The question or 
description can be up to 8,000 characters long. 

5. If desired, to attach a file to submit with the support request, enter the path (drive and folders) and 
file name of the file to attach in the Attach File field, or click the Attach File button to browse to and 
select the file. 
Note:  Only one file can be attached, and the file size cannot be greater than 50MB. 

6. Click the Execute button. 
7. A prompt will appear stating the request has been submitted; click OK. 

 

Program Suggestions 
 

The Program Suggestions feature allows a user to submit a suggestion for a future change or 
enhancement to the School Accounting System or one of the add-on modules.   
 
Submitting a Program Suggestion: 
1. From the main School Accounting System screen or a module's 

main screen, click the Program Suggestions link under the 
Information section. 

2. At the Program Suggestions screen (see Diagram B), the 
customer ID number assigned to your organization by Software 
Unlimited, Inc. displays in the Customer Number field and 
cannot be changed. 

3. In the Name field, enter the name of the user at your 
organization that should be contacted for any additional 
information regarding the suggestion, or click the down-arrow 
button to select the correct one. 

4. Enter a description of the suggestion and an explanation of the 
benefits for the enhancement in the applicable fields.  The 
description and explanation can each be up to 8,000 characters 
long. 

5. Complete the next three fields by clicking the down-arrow 
button and selecting the appropriate response. 

6. If desired, to attach a file to submit with the program 
suggestion, enter the path (drive and folders) and file name of 
the file to attach in the Attach File field, or click the Attach File 
button to browse to and select the file. 
Note:  Only one file can be attached, and the file size cannot be greater than 50MB. 

7. Click the Execute button to submit the suggestion. 
8. A prompt will appear stating the suggestion has been submitted; click OK. 

Diagram A 

Diagram B 

Enter the information into the 
appropriate fields and then 
click the Execute button to 
submit a program suggestion.  
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Backups 
 
The backup database function, which is accessed by clicking the Backup icon on the main screen of the 
School Accounting System or the Backup option listed under the Check Cycle menus in Accounts 
Payable and Payroll, makes an encrypted backup file of the database at a specific point in time.  Since 
all the data in the School Accounting System resides in one database, the backup database function 
backs up all modules including Accounts Payable, General Ledger, Payroll, Fixed Asset Inventory, 
Human Resources, Negotiations, Report Writer, and Accounts Receivable. 
 
When making a backup in the School Accounting System, the backup file of the database is created in 
the backup folder in the SQL Server instance and can be copied to a different location, such as to a 
flash drive or a location on the user's local hard drive, if desired.  The backup files in the backup folder in 
the SQL Server instance are retained based on the values entered in the Number of Days to Keep 
Backups field and the Minimum Number of Backups to Keep field in the System File, while the additional 
backup copies can be stored for longer periods of time as desired. 
 
Tips: 
 Be sure to make a backup prior to updating files in the School Accounting System (for example, 

make a backup prior to updating a check cycle). 
 For organizations using the School Accounting System-Online version, a nightly backup is 

automatically made and the nightly backups are retained for three weeks.  If needed, the previous 
night's backup file is readily available to be restored by contacting Customer Support for assistance 
to access it; if a nightly backup other than the prior night's backup is needed, there may be a fee to 
access it (as that nightly backup file is stored offsite).  

 For organizations with the School Accounting System installed locally, be sure to make 
regular backups of your database in the School Accounting System (such as a weekly or a daily 
backup), in addition to making backups prior to updating files; and develop a schedule for all users 
for when to make backups and establish a procedure for storing the backups in a safe place away 
from the office in case of a fire or other natural disaster.  

 
Note:  For organizations with the School Accounting System installed locally, the School 
Accounting System can be set up to complete daily backups of the database, if desired.  To set up the 
system to make a daily backup, complete the fields on the Backup Options screen in the System File 
(refer to Steps 1, 4, and 5 of the Completing the System File topic in the Help File).  When making a 
daily backup, the backup file is only created in the backup folder in the SQL Server instance (an external 
copy is not made). 
 
Backing Up: 
Note:  The steps below are for completing the backup database function at a specific point in time in the 
School Accounting System. 
1. From the School Accounting System screen, click the Backup icon. 

Note:  The Backup option can also be accessed by selecting the Check Cycle menu and then 
Backup from the Accounts Payable or Payroll screen if backing up prior to updating a batch of 
checks for Accounts Payable or Payroll.  If making a backup as part of completing the Change 
Account Structure, Crosswalk Account Numbers, Purge Data, or Upload Database to SUI option, or 
installing an update, skip this step. 

2. At the Backup Database screen (see Diagram A), enter a description to explain the reason for 
making the backup in the Comment field.  The description can be up to 1,000 characters long.  For 
example, if making a backup prior to updating a batch of checks in Accounts Payable, enter 
Accounts Payable Checks Backup October YYYY in the Comment field.  If applicable (such as 
when making a backup as part of completing an option or installing an update), leave this field blank 
to use a default description assigned by the system. 

3. Select the Make an Additional Copy field to copy the backup from the backup folder (on the SQL 
Server instance) to a different location, such as to a flash drive or a location on the user's local hard 
drive, in order to retain the backup for a longer period of time (than what is stipulated on the Backup 
Options screen in the System File) or store the backup away from the office.  A checkmark will 
appear in the box if the field is selected. 

4. If the Make an Additional Copy field is selected, the Path for Additional Copy field will be enabled.  
Enter the destination location for where to make the additional backup copy in the Path for 
Additional Copy field, or click the Directory button to browse to the desired path and then click the 



OK button.  The path last specified when an additional backup was made on your computer appears 
as the default, but can be changed. 

5. Click the Execute button to backup the database. 
Tip:  The name of the backup file will include the date and time the backup was made, using the 
following format:  XX_####_OrganizationName_yyyy-mm-dd_hhmmss, with XX being the 
appropriate state abbreviation and #### being the customer ID number for the organization.  The 
backup file created in the backup folder will have a file extension of .bak, while the additional backup 
file copied to the specified location (if applicable) will have a file extension of .gz. 

6. Once the backup file (.bak file) has been created, the Backup Database screen will close.  If an 
additional copy was selected to be made, the system will start creating the additional backup file (.gz 
file) after the screen closes and will continue working in the background.  (Tip:  If the additional 
backup file is being made on a removable drive (i.e. a flash drive), keep the removable drive 
connected until the additional copy has been completed.) 
Note:  The Backup Database screen will remain open until the additional copy (if applicable) was 
created if making a backup while installing an update to the School Accounting System or 
completing the Upload Database to SUI Support option. 

4-b 

Diagram A 

Add a comment to explain the 
reason for the backup here.   

Select the Make an Additional Copy field and 
complete the Path for Additional Copy field to copy 
the backup to a different location, such as to a flash 
drive or a location on the user's local hard drive.  
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Printing Reports from within Report Writer 
 
Printing a Report from within Report Writer: 
Note:  If printing a report from the Edit Report screen, skip to Step 2. 
1. From the Report Writer screen, click on the name of the view group in the Report Groups List that 

contains the report to print and then click on the name of the report in the Reports List (or click the 
Find button instead to search for the desired report).  See Diagram A. 

2. Click the Execute button located at the top of the screen. 
3. If printing mailing labels, when prompted, select the label setup for which to use by double-clicking 

on the desired format. 
4. Complete the required report printing options, if applicable. 
5. If desired, click the Save Settings button at this time to save the specified report printing options in 

order to run the report with these exact settings in the future by utilizing the Retrieve Settings 
button.  If you do not click the Save Settings button at this time, the settings must be re-entered the 
next time the report is generated. 
Tip:  A report can also be set as a favorite report (for the user) at this time by clicking the Favorite 
Reports button, or the report can be added to the user's report list accessed under the Reports 
menu on a module's main screen by clicking the Report List button.  

6. Click the appropriate button for the desired output: 
a. To preview the report on the screen, click the To Screen button. 
b. To print the report directly to the printer (as designated in the Printer Setup option), click the To 

Printer button. 
c. To export the report to a file, click the Export button and then complete the Export Options as 

desired. 
Tip:  A report previewed on the screen can also be exported to a file by clicking the Export 
button on the preview screen. 

d. To email the report, click the Email button.  Refer to the Emailing a Report topic for 
requirements to email a report 
Tip:  A report previewed on the screen can also be emailed by clicking the Email button on the 
preview screen. 

e. For organizations with the K12Docs module licensed and users with the applicable rights, click 
the Upload to K12Docs button to upload the report to K12Docs. 
Tip:  A report previewed on the screen can also be uploaded by clicking the Upload to 
K12Docs button on the preview screen. 

7. After the report is printed, click the X in the upper right-hand corner to close the reporting printing 
options screen, if applicable. 

Diagram A 

Click the name of the report and 
then click the Execute button. 



Report Writer Defaults 
 
The Report Writer Defaults option in Report Writer is used to define the default settings and formats 
used for custom reports created in the School Accounting System (for all users), including board reports, 
flexible financial reports, and the reports designed in Report Writer.  The setting and formatting options 
that can be defined within the Report Writer Defaults option include the paper source, margins, 
orientation, fonts, field formats, and grid settings, to name a few.  
 
Completing the Report Writer Defaults: 
Note:  The settings and formats defined within the Report Writer Defaults option will be utilized when 
creating new custom reports and when making applicable changes to existing custom reports (for 
example, when adding a new field to an existing report, the system will use the defaults for the 
appropriate field type). 
1. From the Report Writer screen, select the Maintenance menu and then Report Writer Defaults. 
2. At the Report Writer Defaults screen, click the Printer Settings tab and complete the following: 

a. Enter the option (Collate, Don't Collate, or Printer Default) to use as the default for collating 
reports in the Collate field, or click the down-arrow button to select the correct one.  To print in 
sets (page number order) if multiple copies are printed and a report is multiple pages long, enter 
Collate.  To print all the copies of each page together (not collated), enter Don't Collate.  To 
print using the default setting for whether or not to collate from the printer preferences for the 
applicable printer, enter Printer Default.  See Diagram A. 

b. Enter the option (Horizontal, Printer Default, Simplex, or Vertical) to use as the default for 
duplexing reports in the Duplex field, or click the down-arrow button to select the correct one.  
To print on both sides of the paper using a horizontal page turn, enter Horizontal.  To print 
using the default setting for duplex from the printer preferences for the 
applicable printer, enter Printer Default.  To print on only one side of the 
paper (not duplexed), 
enter Simplex.  To print 
on both sides of the paper 
using a vertical page turn, 
enter Vertical. 

c. In the Paper Source field, 
enter the name of the 
paper source to use as the 
default for which the 
reports will print (for 
example, the paper tray 
from which the printer gets 
the paper to print the 
reports), or click the down
-arrow button to select the 
correct one.  The 
selections available for the 
paper source are based on the paper sources defined for the default printer. 

d. Enter the desired page orientation (Portrait or Landscape) to use as the default for reports in 
the Orientation field, or click the down-arrow button to select the correct one.  To print the 
reports with the long edge of the paper down the side, enter Portrait.  To print the reports with 
the long edge of the paper on the top and bottom, enter Landscape. 

e. Enter the distance in inches to use as the default from the top edge of the paper to where the 
information should start printing on the reports in the Top Margin field.  The margin cannot be 
greater than 10 inches, but can be up to 5 digits long (including the decimal point) and will be 
rounded to 2 decimal places by the system if capable. 

f. Enter the distance in inches to use as the default from the bottom edge of the paper to where 
the information should stop printing on the report in the Bottom Margin field.  The margin cannot 
be greater than 10 inches, but can be up to 5 digits long (including the decimal point) and will be 
rounded to 2 decimal places by the system if capable. 

g. Enter the distance in inches to use as the default from the left edge of the paper to where the 
information should start printing on the report in the Left Margin field.  The margin cannot be 
greater than 10 inches, but can be up to 5 digits long (including the decimal point) and will be 
rounded to 2 decimal places by the system if capable. 
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Diagram A 

Click the Printer Settings tab to 
complete printing preferences. 



h. Enter the distance in inches to use as the default from the right edge of the paper to where the 
information should stop printing on the report in the Right Margin field.  The margin cannot be 
greater than 10 inches, but can be up to 5 digits long (including the decimal point) and will be 
rounded to 2 decimal places by the system if capable. 

3. Click the Save button. 
4. Click the Data Formats tab and complete the following: 

a. To select the desired true/false style to use as the default for boolean (true/false) fields included 
on reports, click the Search button in the Format field (column) to the right of Boolean.  On the 
Boolean Format screen, select the true/false style to use as the default by clicking once on the 
desired format.  Select X/ to print 'X' on the report for the field if it is true, or print nothing if it is 
false.  Select True/False, to print 'True' on the report for the field if it is true, or print 'False' if it is 
false.  Select Yes/No, to print 'Yes' on the report for the field if it is true, or print 'No' if it is false.  
Select T/F, to print 'T' on the report for the field if it is true, or print 'F' if it is false.  Select Y/N, to 
print 'Y' on the report for the field if it is true, or print 'N' if it is false.  Select */, to print an asterisk 
(*) on the report for the field if it is true, or print nothing if it is false.  Once the desired true/false 
style is selected, click the Save button.  See Diagram B. 

b. To select the desired date format to use as the default for date fields included on reports, click 
the Search button in the Format field (column) to the right of Date.  On the Date Format screen, 
select the date format to use as the default by clicking once on the desired format.  Once the 
desired date format is selected, click the Save button. 

c. To select the desired negative style, number of decimal places, comma style, and currency style 
to use as the default for decimal fields included on reports, click the Search button in the Format 
field (column) to the right of Decimal.  On the Decimal Format screen, complete the following: 

 In the Formats List (on the left side of the screen), select the desired negative style format 
(and currency style) to use as 
the default for decimal fields 
with negative values by 
clicking once on the desired 
format.  The negative styles 
include printing a minus sign 
in front of the negative value, 
printing parenthesis around 
the negative value, or printing 
the negative value as a 
positive number. 

 Enter the number of decimal 
places (0 to 4) to use as the 
default in the Decimal Places 
field.  Leave the field blank to 
default to 0. 

 Select the Display Comma field to print commas in the values for decimal fields, if 
applicable.  A checkmark will appear in the box if the field is selected. 

 Select the Display Dollar Sign field to print dollar signs with the values for decimal fields.  A 
checkmark will appear in the box if the field is selected. 

 Click the Save button. 

d. To select the desired negative style and comma style to use as the default for integer fields 
included on reports, click the Search button in the Format field (column) to the right of Integer.  
On the Integer Format screen, complete the following: 

 In the Formats List (on the left side of the screen), select the desired negative style format to 
use as the default for integer fields with negative values by clicking once on the desired 
format.  The negative styles include printing a minus sign in front of the negative value, 
printing parenthesis around the negative value, or printing the negative value as a positive 
number. 

 Select the Display Comma field to print commas in the values for integer fields, if applicable.  
A checkmark will appear in the box if the field is selected. 

 Click the Save button. 
e. To select the desired month (date) format to use as the default for month fields included on 

reports, click the Search button in the Format field (column) to the right of Month.  On the Month 

6-b 

Diagram B 

Click the Data Formats tab to set the 
default formats for the various types of 
data fields inserted into reports. 



Format screen, select the month (date) format to use as the default by clicking once on the 
desired format.  Once the desired format is selected, click the Save button. 

f. To select the desired negative style, number of decimal places, and comma style to use as the 
default for percent fields included on reports, click the Search button in the Format field 
(column) to the right of Percent.  On the Percent Format screen, complete the following: 

 In the Formats List (on the left side of the screen), select the desired negative style format to 
use as the default for percent fields with negative values by clicking once on the desired 
format.  The negative styles include printing a minus sign in front of the negative value, 
printing parenthesis around the negative value, or printing the negative value as a positive 
number. 

 Enter the number of decimal places (0 to 4) to use as the default in the Decimal Places field.  
Leave the field blank to default to 0. 

 Select the Display Comma field to print commas in the values for percent fields, if 
applicable.  A checkmark will appear in the box if the field is selected. 

 Click the Save button. 

5. Click the Save button. 
6. Click the Section Fonts tab and complete 

the following: 
a. To select the font, font style, color, and 

size to use as the default for fields 
included in the Report Header section 
on reports, click the Search button in 
the Section Name field (column) to the 
right of Report Header.  On the Font 
screen, select the desired font, font 
style, color, and size, and then click the 
OK button.  See Diagram C. 

b. To select the font, font style, color, and 
size to use as the default for fields 
included in the Page Header section on reports, click the Search button 
in the Section Name field (column) to the right of Page Header.  On the Font screen, select the 
desired font, font style, color, and size, and then click the OK button. 

c. To select the font, font style, color, and size to use as the default for fields included in the Group 
Header section on reports, click the Search button in the Section Name field (column) to the 
right of Group Header.  On the Font screen, select the desired font, font style, color, and size, 
and then click the OK button. 

d. To select the font, font style, color, and size to use as the default for fields included in the Detail 
section on reports, click the Search button in the Section Name field (column) to the right of 
Detail.  On the Font screen, select the desired font, font style, color, and size, and then click the 
OK button. 

e. To select the font, font style, color, and size to use as the default for fields included in the Group 
Footer section on reports, click the Search button in the Section Name field (column) to the right 
of Group Footer.  On the Font screen, select the desired font, font style, color, and size, and 
then click the OK button. 

f. To select the font, font style, color, and size to use as the default for fields included in the Page 
Footer section on reports, click the Search button in the Section Name field (column) to the right 
of Page Footer.  On the Font screen, select the desired font, font style, color, and size, and then 
click the OK button. 

g. To select the font, font style, color, and size to use as the default for fields included in the Report 
Footer section on reports, click the Search button in the Section Name field (column) to the right 
of Report Footer.  On the Font screen, select the desired font, font style, color, and size, and 
then click the OK button. 

7. Click the Save button. 
8. Click the Grid Settings tab and complete the following: 

a. Select the Display Grid field to have grid lines (dots) appear on the screen when editing a report 
in Report Writer to aid in aligning fields on reports.  A checkmark will appear in the box if the 
field is selected.  See Diagram D. 

6-c 

Diagram C 

Click the Section Fonts tab to set the 
default font for each section of a report. 



b. Enter the option (Align to Grid, Display Alignment Lines, or None) for aligning (moving)
objects on reports in the Grid Control Alignment field, or click the down-arrow button to select 
the correct one.  To align objects on reports to the grid lines (dots) when moving, enter Align to 
Grid.  To move objects on reports freely and display horizontal and vertical layout guidelines 
when an object is aligned with another object (in the same section or another section), enter 
Display Alignment Lines.  To move objects on reports freely without displaying any layout 
guidelines, enter None. 

c. Enter the number of lines (dots) to include per inch on the columns of the grid in the Grid 
Columns field.  The number can be from 2 to 99. 

d. Enter the number of lines (dots) to include per inch on the rows in the grid in the Grid Rows field.  
The number can be from 2 to 99. 

e. Select the Auto Insert Heading field to have the system automatically insert column headings in 
the Page Header section of a report when fields are added to the Detail section.  A checkmark 
will appear in the box if the field is selected. 

f. Select the Auto Insert Subtotals field to have the system automatically insert subtotals in the 
Report Footer and Group Footer sections of a report when decimal fields are added to the Detail 
section.  A checkmark will appear in the box if the field is selected. 

9. Click the Save button. 
10. Click the X in the upper right-hand corner to close the Report Writer Defaults screen. 
 

6-d 

Diagram D 

Click the Grid Settings tab to 
complete the grid preferences. 



Report Categories 
 

Report Categories are used in Report Writer to define the groupings of reports listed under the Reports 
menu on each module's main screen.  The report categories are used as shortcuts to locate a report 
related to a particular category or grouping. 
 
Note:  The report categories of Pre-Check Reports (AP), Post-Check Reports (AP), Pre-Check Reports 
(PR), and Post-Check Reports (PR) are used to define the reports that are listed under those categories 
under the Check Cycle menu rather than the Reports menu. 
  
Adding a Report Category: 
1. From the Report Writer screen, select the Maintenance menu and then Report Categories. 
2. At the Report Categories screen, click the New Record button. 

Note:  For any field equipped with the repeat function, click the Repeat button or press the Ctrl+R 
keys to repeat the previous entry for the specified field.  The repeat function is only available after 
your initial entry. 

3. Enter a unique description for the report category in the Category Description field.  The description 
can be up to 40 characters long.  See Diagram A. 
Note:  The description cannot end with the word "favorites". 

4. To have the report category display under the Reports menu on the main screen for only one 
module, enter the ID of the desired module in the Module ID field, or click the down-arrow button to 
select the correct one.  Otherwise, to have the report category display under the Reports menu on 
the main screen for the applicable modules, leave the Module ID field blank. 
Tip:  If the Module ID field is completed for a report category, the category will only appear in the 
one module and will list all the selected reports under that category, even if the report contains 
information for a different module; for example, if a report category was created with GL specified in 
the Module ID field and the Balance Sheet and Vendor Inquiry reports selected, the report category 
would only appear under the Reports menu in General Ledger and show both the Balance Sheet 
and Vendor Inquiry reports.  If the Module ID field is left blank for a report category, the category will 
appear under the Reports menu in all the applicable modules for which there are selected reports; 
for example, if a report category was created with the Module ID field left blank and the Balance 
Sheet and Vendor Inquiry reports selected, the report category would appear under the Reports 
menu in General Ledger showing the Balance Sheet report and in Accounts Payable showing the 
Vendor Inquiry report. 
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Specify which reports to display 
under the report category by 
clicking the Selected column. 



Note:  Only the modules for which the organization has licensed are available to be entered or 
selected in this field. 

5. The System Category field is disabled and cannot be changed.  A checkmark will only appear in the 
box if the report category is a standard one created by Software Unlimited, Inc. 

6. The User Category field is disabled and cannot be changed.  A checkmark will appear in the box if 
the report category is one created from within the User Options option or User Security option for 
defining "favorite" reports for a user. 

7. In the Reports List, specify which reports to display under the report category by clicking the box for 
the Selected column to the left of each desired report.  A checkmark will appear in the box if the 
report is selected.  Only the reports in the modules for which the organization has licensed appear in 
the Reports List. 
Note:  If a report has report selections, the default report selection can be set for the report in the 
Report Selection Description field (column) by clicking the down-arrow button and selecting the 
desired one. 
Tip:  The System Relationship field (column) will display a checkmark in the box if a standard report 
was defined with the report category selected. 

8. Click the Save button. 
 
Changing a Report Category: 
1. From the Report Writer screen, select the Maintenance menu and then Report Categories. 
2. At the Report Categories screen, enter the description of the report category to change in the 

Category Description field.  If the exact description is not known, click the down-arrow button or the 
Find button to select the correct one. 

3. Make the desired changes to the report category. 
a. To add a report so that it displays under the report category, click the box for the Selected 

column to the left of the desired report.  A checkmark will appear in the box if the report is 
selected. 

b. To remove a report so that it no longer displays under the report category, click the box for the 
Selected column to the left of the desired report to remove the checkmark. 

Note:  If a report category is defined with the System Category field selected, the only changes that 
can be made include selecting additional reports to display under the report category and removing 
reports that do not have the System Relationship field selected. 

4. After all the changes have been made, click the Save button. 
5. If the description for the report category was changed, a prompt will appear verifying whether or not 

to change the report category or add a new one.  To change the description for the report category, 
click the Change button.  To not change the description and revert to use the original description, 
click the Revert to Original button.  To add a new report category with the specified description that 
is a duplicate of the current report category, click the Create New button. 

 
Deleting a Report Category: 
Note:  If a report category is defined with the System Category field selected, the system will not allow it 
to be deleted. 
1. From the Report Writer screen, select the Maintenance menu and then Report Categories. 
2. At the Report Categories screen, enter the description of the report category to delete in the 

Category Description field. If the exact description is not known, click the down-arrow button or the 
Find button to select the correct one. 

3. Once the report category to delete is displayed on the screen, click the Delete button; when 
prompted to delete the record, click Yes. 
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Custom Reports 
 

Custom reports are reports created by a user within the Report Writer module or a report setup option in 
the School Accounting System, such as the Board Report Setup option in Accounts Payable.  When 
creating a custom report, a user can add the desired fields of information to include on the report, and 
specify how to sort the information.  The creation of custom reports allows a user to tailor the reports to 
meet the organization's informational reporting needs.  
  
Adding a Report: 
1. From the Report Writer screen, select the report group (query or view group) for which to add the 

new custom report by clicking on the name of the view group in the Report Groups List. 
Tip:  If desired, click the Directory button after clicking on a report group to view a list of the files 
from which fields can be included on a report in the particular report group. 

2. Click the New Record button located at the top of the screen to create a new report in the selected 
report group.  See Diagram A. 

3. Complete the report settings for the new report.  See Page 9-a for further details. 
4. Define the categories/screens for the new report.  See Page 10-a for further details. 

5. The Edit Report screen will appear for the report, showing the Page Header, 
Detail, and Page Footer sections. 

6. At the Edit Report screen, enter the information to be printed in the Page Header section, or 
suppress the Page Header section so that it does not print, if desired.  Insert special fields, database 
fields, labels, lines, shapes, or images into the Page Header section, as desired, and then resize, 
format, move, and align the items (objects) as needed. 
Note:  When creating a new report, the system automatically includes six standard header fields in 
the Page Header section, but the fields can be changed or deleted, if desired.  The six standard 
header fields include the system field from the database for the organization name and the special 
fields of Report Name, Page Number, Print Date, Sub Heading, and User ID. 
Tip:  If the standard header fields are not centered within the Page Header section, click the Adjust 
Header Fields button to align the standard header fields correctly within the Page Header section.  
If the Page Header section is not needed, suppress the section so that it does not print by first 
clicking the title bar for the section and then selecting False in the Visible field under the Behavior 
section in the Properties List. 

7. Enter the information to be printed in the Detail section, or suppress the Detail section so that it does 
not print, if desired.  Insert special fields, database fields, formulas, labels, lines, shapes, images, 
subreports, or barcodes into the Detail section, as desired, and then resize, format, move, and align 
the items (objects) as needed. 
Tip:  If the Detail section is not needed, suppress the section so that it does not print by first clicking 
the title bar for the section and then selecting False in the Visible field under the Behavior section in 
the Properties List. 
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Diagram A 

To add a new custom report, 
select the desired report group 
and then the New Record button. 



8. Enter the information to be printed in the Page Footer section, or suppress the Page Footer section 
so that it does not print, if desired.  Insert database fields, formulas, labels, lines, shapes, images, 
subreports, or barcodes into the Page Footer section, as desired, and then resize, format, move, 
and align the items (objects) as needed. 
Note:  Initially, the height for the Page Footer section will be set to zero (0), and the section will need 
to be resized prior to inserting any objects into the section. 
Tip:  If the Page Footer section is not needed, leave the height set to zero (0) if there are no objects 
in the section, or else suppress the section so that it does not print by first clicking the title bar for the 
section and then selecting False in the Visible field under the Behavior section in the Properties List. 

9. If desired, add the Report Header and Report Footer sections to the report, and then enter the 
information to be printed in the sections.  To add the Report Header and Report Footer sections, 
select the Insert menu and then Report Header/Footer.  The Report Header and Report Footer 
sections will be included on the report.  If one of the sections is not needed, suppress the section so 
that it does not print.  Insert database fields, formulas, labels, lines, shapes, images, subreports, or 
barcodes into the Report Header and Report Footer sections, as desired, and then resize, format, 
move, and align the items (objects) as needed. 
Tip:  If the Report Header or Report Footer section is not needed, suppress the section so that it 
does not print by first clicking the title bar for the desired section and then selecting False in the 
Visible field under the Behavior section in the Properties List. 

10. If desired, add groups to the report, and then enter the information to be printed in the Group Header 
and Group Footer sections.  Insert database fields, formulas, labels, lines, shapes, images, 
subreports, or barcodes into the Group Header and Group Footer sections, as desired, and then 
resize, format, move, and align the items (objects) as needed.  Also, utilize the Properties 
List (located in the lower right corner of the screen) to change the defined properties for the Group 
Header and Group Footer sections, if desired.  See Page 11-a for further details on adding a group. 
Tip:  If the Group Header or Group Footer section is not needed, suppress the section so that it 
does not print by first clicking the title bar for the desired section and then selecting False in the 
Visible field under the Behavior section in the Properties List. 

11. If desired, add report parameters to the report.  See Page 14-a for further details. 
12. If desired, add a filter records formula to the report.  See Page 12-a for further details. 
13. If desired, add report selections to the report. 
14. Click the Save button. 
 
Editing a Report: 
Note:  Below are the steps to edit a custom report in Report Writer.  If desired, standard reports can be 
copied and modified to fit the needs of the district. 
1. From the Edit Report screen for the selected report, make the desired changes to the report. 

Note:  If the report to edit is not yet open, first complete the following:  from the Report Writer 
screen, click on the name of the view group in the Report Groups List that contains the report to edit 
and click on the name of the report in the Reports List (or click the Find button instead to search for 
the desired report); then click the Edit Record button located at the top of the screen. 

2. To edit the name of the report, or the margins, orientation, and paper size, change the report 
settings.  See Page 9-b for further details. 

3. To edit the report categories and screens within the School Accounting System where the report is 
listed (can be accessed), change the categories/screens.  See Page 10-a for further details. 
Note:  The categories/screens can be changed for standard reports, if desired. 

4. Edit the information to be printed in the Page Header section, or suppress the Page Header section 
so that it does not print, if desired.  Insert special fields, database fields, labels, lines, shapes, or 
images into the Page Header section, as desired, and then resize, format, move, and align the items 
(objects) as needed. 
Note:  When creating a new report, the system automatically includes six standard header fields in 
the Page Header section, but the fields can be changed or deleted, if desired.  The six standard 
header fields include the system field from the database for the organization name and the special 
fields of Report Name, Page Number, Print Date, Sub Heading, and User ID. 
Tip:  If the standard header fields are not centered within the Page Header section, click the Adjust 
Header Fields button to align the standard header fields correctly within the Page Header section.  If 
the Page Header section is not needed, suppress the section so that it does not print by first clicking 
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the title bar for the section and then selecting False in the Visible field under the Behavior section in 
the Properties List. 

5. Edit the information to be printed in the Detail section, or suppress the Detail section so that it does 
not print, if desired.  Insert special fields, database fields, formulas, labels, lines, shapes, images, 
subreports, or barcodes into the Detail section, as desired, and then resize, format, move, and align 
the items (objects) as needed. 
Tip:  If the Detail section is not needed, suppress the section so that it does not print by first clicking 
the title bar for the section and then selecting False in the Visible field under the Behavior section in 
the Properties List. 

6. Edit the information to be printed in the Page Footer section, or suppress the Page Footer section so 
that it does not print, if desired.  Insert database fields, formulas, labels, lines, shapes, images, 
subreports, or barcodes into the Page Footer section, as desired, and then resize, format, move, 
and align the items (objects) as needed. 
Note:  Initially, the height for the Page Footer section will be set to zero (0), and the section will need 
to be resized prior to inserting any objects into the section. 
Tip:  If the Page Footer section is not needed, leave the height set to zero (0) if there are no objects 
in the section, or else suppress the section so that it does not print by first clicking the title bar for the 
section and then selecting False in the Visible field under the Behavior section in the Properties List. 

7. If desired, add the Report Header and Report Footer sections to the report, and/or edit the 
information to be printed in the sections.  To add the Report Header and Report Footer sections, 
select the Insert menu and then Report Header/Footer.  The Report Header and Report Footer 
sections will be included on the report.  If one of the sections is not needed, suppress the section so 
that it does not print.  Insert database fields, formulas, labels, lines, shapes, images, subreports, or 
barcodes into the Report Header and Report Footer sections, as desired, and then resize, format, 
move, and align the items (objects) as needed. 
Tip:  If the Report Header or Report Footer section is not needed, suppress the section so that it 
does not print by first clicking the title bar for the desired section and then selecting False in the 
Visible field under the Behavior section in the Properties List. 

8. If desired, add groups to the report, remove groups, and/or edit the information to be printed in the 
Group Header and Group Footer sections.  Insert database fields, formulas, labels, lines, shapes, 
images, subreports, or barcodes into the Group Header and Group Footer sections, as desired, and 
then resize, format, move, and align the items (objects) as needed.  Also, utilize the Properties 
List (located in the lower right corner of the screen) to change the defined properties for the Group 
Header and Group Footer sections, if desired.  See Page 11-a for further details on adding a group. 
Tip:  If the Group Header or Group Footer section is not needed, suppress the section so that it 
does not print by first clicking the title bar for the desired section and then selecting False in the 
Visible field under the Behavior section in the Properties List. 

9. If needed, add report parameters to the report, or change or delete report parameters.  See Page 14
-a for further details. 

10. If needed, add a filter records formula to the report, or change the filter records formula.  See Page 
12-a for further details. 

11. If needed, add report selections to the report, or change or delete report selections. 
12. After all the changes have been made, click the Save button. 
 
Deleting a Report: 
Note:  Below are the steps to delete a custom report in Report Writer. Standard reports cannot be 
deleted. 
1. From the Report Writer screen, click on the name of the view group in the Report Groups List that 

contains the report to delete, or click the Find button instead to search for the desired report. 
2. In the Reports List, click the Delete button to the left of the name of the report to delete. 
3. When prompted to delete the report, click Yes. 
 
Inserting a Database Field or Formula on a Report: 
Note:  The instructions below are for inserting a database field or existing formula on a custom report. 
1. In the Fields List located in the upper right corner on the Edit Report screen, click the applicable tab 

for the field or formula to insert into the report.  Click the Fields tab to insert a typical database 
field.  Click the Formulas tab to insert an existing formula created within the specified report group 
(query or view group).  Click the Variable Fields tab to insert a variable field, which is a field that 
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requires data to be selected in order to generate the report, such as the Processing Month 
field.  Click the System Fields tab to insert a field from one of the System Files in the School 
Accounting System, such as the main System File or the Payroll System File. 
Note:  If the report to edit is not yet open, first complete the following:  from the Report Writer 
screen, click on the name of the view group in the Report Groups List that contains the report for 
which to add a field or formula and click on the name of the report to edit in the Reports List (or click 
the Find button instead to search for the desired report); then click the Edit Record button located 
at the top of the screen. 

2. On the selected tab in the Fields List, select the file that contains the field to insert by clicking once 
on the box (plus sign) in front of the file name or double-clicking on the file name, and then click on 
the desired field or formula name.  

3. With the field or formula selected, click, drag, and drop the field or formula to the desired section and 
location on the report.  

4. The field or formula will appear in the designated location.  A text field or formula will appear as an 
object filled with Xs, a numeric field or formula will appear as an object with #s and 0s, a date field or 
formula will appear as an object using the default date format (for example, mm/dd/yyyy), and a 
boolean (true/false) field or formula will appear as an object using the default true/false format (for 
example, X/). 

5. Resize, format, move, and align the field or formula as needed. 
Tip:  The following buttons (and corresponding options under the Format menu) are available to 
format a database field or formula:  Bold button, Italic button, Underline button, Font Settings 
button, Align button, Back Color button, Fore Color button, and Border button.  Additional 
properties can be set for a database field or formula using the following fields within the Properties 
List:  Vertical Alignment (Top, Middle, or Bottom), Can Grow (True or False), Can Shrink (True or 
False), Optional (True or False), Output Format (to select the date format for date fields or 
formulas; to select the true/false style for boolean (true/false) fields or formulas; or to select the 
negative style format, number of decimal places, and whether to display a comma or dollar sign for 
numeric fields or formulas), Hide If Zero (True or False; only applicable for numeric fields or 
formulas), and Summary Func (Sum, Avg, Count, Min, Max, DCount, or None; only applicable for 
numeric fields or formulas). 

6. Click the Save button. 
 
Inserting a Label on a Report: 
Note:  The instructions below are for inserting a label on a custom report. 
1. On the Edit Report screen, click the Label button, or select the Insert menu and then Label. 

Note:  If the report to edit is not yet open, first complete the following:  from the Report Writer 
screen, click on the name of the view group in the Report Groups List that contains the report for 
which to add a label and click on the name of the report to edit in the Reports List (or click the Find 
button instead to search for the desired report); then click the Edit Record button located at the top 
of the screen. 

2. Click at the location within the desired section on the report for where to add the label, and drag and 
drop to the desired size of the label. 

3. The label will appear in the designated section and appear as an object with the text of Label1. 
4. To enter or change the text for the label, either double-click on the label and key the new text over 

the existing text, or else:   

 Click the object (label). 

Tip:  After an object is selected, handles (boxes) will appear around the outside edges of the 
selected object.  To select multiple objects for which to enter or change the label text at the 
same time, press and hold the Shift or Ctrl key and then select (click) all the desired items, or 
else click, drag, and drop a box (using your mouse) over all the desired objects.  To select all 
objects within a section, click the title bar for the section and then press the Ctrl+A keys. 

 With the label selected, click in the Text field under the Data section in the Properties List 
(located in the lower right corner of the screen) and either key the new text over the existing 
text, or else click the button (in the Text field) and then at the Text screen, key the desired text 
and click the Save button. 

5. Resize, format, move, and align the label as needed. 
Tip:  The following buttons (and corresponding options under the Format menu) are available to 
format a label:  Bold button, Italic button, Underline button, Font Settings button, Align 
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button, Back Color button, Fore Color button, and Border button.  Additional properties can be set 
for a label using the following fields within the Properties List:  Vertical Alignment (Top, Middle, or 
Bottom), Can Grow (True or False), Can Shrink (True or False), and Optional (True or False). 

6. Click the Save button. 
 
Resizing Objects on a Report: 
Note:  The instructions below are for resizing an object (field, formula, label, line, shape, image, 
barcode, or subreport) already inserted into a custom report. 
1. Click the object (field, formula, label, line, shape, image, barcode, or subreport) for which to resize. 

Tip:  After an object is selected, handles (boxes) will appear around the outside edges of the 
selected object.  To select multiple objects to resize at the same time, press and hold the Shift or 
Ctrl key and then select (click) all the desired items to resize, or else click, drag, and drop a box 
(using your mouse) over all the desired objects.  To select all objects within a section, click the title 
bar for the section and then press the Ctrl+A keys. 
Note:  If the report to edit is not yet open, first complete the following:  from the Report Writer 
screen, click on the name of the view group in the Report Groups List that contains the report for 
which to resize an object and click on the name of the report to edit in the Reports List (or click the 
Find button instead to search for the desired report); then click the Edit Record button located at 
the top of the screen. 

2. To resize the selected object using your mouse: 

 Place the cursor (pointer) on a resizing handle (box) on the outside edge of the object.  The 
pointer will change to a two-headed arrow when over a resizing handle. 

 Then click the sizing handle with the two-headed arrow and drag and drop to the desired size. 

Tip:  To resize the height and width of an object at the same time, click and drag a sizing handle in 
the corner of the object. 

3. To resize the selected object using the keyboard: 

 Hold the Shift key and then press the right-arrow, left-arrow, up-arrow, or down-arrow 
key.  Depending on the option specified in the Grid Control Alignment field within the Report 
Writer Defaults option, the object will be resized as follows: 

Option Object Action 
Align to Grid Resized by one line (dot) on the grid 
Display Alignment Lines Resized to the nearest edge of the next closest object 
None Resized by one space 

Note:  If desired, hold the Ctrl+Shift keys and then press the right-arrow, left-arrow, up-
arrow, or down-arrow key to resize the object by one space (applicable for all Grid Control 
Alignment options). 
Tip:  If the Shift key is not pressed, the object will move instead of being resized.  Also, if the 
Ctrl key is pressed, clicking, dragging, and dropping the object will make a copy of the object. 

4. The selected object can also be resized using the following fields in the Properties List (located in 
the lower right corner of the screen): 

 Height - located under the Layout section and used to set the exact height of the object using 
inches. 

 Width - located under the Layout section and used to set the exact width of the object using 
inches. 

5. Click the Save button. 
 
Formatting Objects on a Report: 
Note:  The instructions below are for formatting an object (field, formula, label, line, shape, image, 
barcode, or subreport) already inserted into a custom report. 
1. Click the object (field, formula, label, line, shape, image, barcode, or subreport) for which to format. 

Tip:  After an object is selected, handles (boxes) will appear around the outside edges of the 
selected object.  To select multiple objects to format at the same time, press and hold the Shift or 
Ctrl key and then select (click) all the desired items to format, or else click, drag, and drop a box 
(using your mouse) over all the desired objects.  To select all objects within a section, click the title 
bar for the section and then press the Ctrl+A keys. 
Note:  If the report to edit is not yet open, first complete the following:  from the Report Writer 
screen, click on the name of the view group in the Report Groups List that contains the report for 
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which to format an object and click on the name of the report to edit in the Reports List (or click the 
Find button instead to search for the desired report); then click the Edit Record button located at 
the top of the screen. 

2. Click the applicable button, or select the Format menu and then the desired formatting option:   

 Bold - to print the text for a field, formula, label, or barcode in boldface. 

 Italic - to print the text for a field, formula, label, or barcode in italics. 

 Underline - to print the text in a field, formula, label, or barcode with a single underline. 

 Font Settings - to set the font, font style, size, and effects of the text for a field, formula, label, 
or barcode. 

 Align - to set the horizontal alignment of the text within a field, formula, label, or barcode; must 
select Left, Center, Right, or Justify. 

 Back Color - to set the background (fill) color of the field, formula, label, shape, image, or 
barcode. 

 Fore Color - to set the foreground (text) color of the field, formula, label, or barcode. 

 Line Color - to set the color of the line. 

 Line Style - to set the style of the line; must select Transparent, Solid, Dash, Dot, Dash Dot, 
or Dash Dot Dot.  

 Border - to print a border around a field, formula, label, shape, image, barcode, or subreport. 

3. Additional formatting options are available in the Properties List (located in the lower right corner of 
the screen) using the following fields: 

 Auto Size - located under the Behavior section and used to specify to automatically size a 
barcode to fit the width of the object; must select True or False. 

 Can Grow - located under the Behavior section and used to set a field, formula, label, or 
subreport so that the height of the object expands in order to print all the text, if applicable; must 
select True or False.  For example, if the text is too long to print in one line (for the height and 
width of the field) and True is specified in the Can Grow field, the height of the object will 
increase for that one record and the data will wrap to additional lines in order to print all the text 
for the field; if the Can Grow field is set to False, the text would just be cut off for the field (would 
not wrap). 
Note:  If True is specified in the Can Grow field for a field, formula, label, or subreport, the 
section in which the object is included must also have True in the Can Grow field for the section 
properties. 

 Can Shrink - located under the Behavior section and used to set a field, formula, label, or 
subreport so that the height of the object decreases to omit blank space from printing, if 
applicable; must select True or False.  For example, if the text only fills up one line of the width 
of the field and the height is set for three lines, and True is specified in the Can Shrink field, the 
height of the object will decrease for that one record to be just one line high; if the Can Shrink 
field is set to False, the one line of text will print followed by two blank lines in the field. 
Note:  If True is specified in the Can Shrink field for a field, formula, label, or subreport, the 
section in which the object is included must also have True in the Can Shrink field for the 
section properties. 

 Caption Position - located under the Behavior section and used to set the location of the caption 
for a barcode (the caption is the data for the field tied to the barcode); must select None, 
Above, or Below. 

 Check Sum Enabled - located under the Behavior section and used to have the system verify 
the computation of a barcode; must select True or False. 

 Hide if Zero - located under the Data section and used to suppress (not print) the field if the 
value is zero (0) for a numeric field or formula; must select True or False. 

 Line Weight - located under the Appearance section and used to set the weight (thickness) of a 
line for a line, shape, or image using pixels. 
Note:  The line color and line style for a shape or image can also be changed, if desired, by 
using the Line Color and Line Style fields also located under the Appearance section (the Line 
Color button and Line Style button (and the corresponding options under the Format menu) 
are only enabled for lines, not shapes or images). 
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 Optional - located under the Behavior section and used to set a field, formula, label, line, shape, 
image, barcode, or subreport as optional in order for the user to select whether or not to include 
(print) the object when generating the report; must select True or False. 

 Output Format - located under the Data section and used for different purposes depending on 
the type of the field or formula: 

 For date and month fields or formulas - click in the field and click the button to specify the 
desired date or month format; then click the Save button.   

 For numeric fields or formulas - click in the field and click the button to specify the desired 
negative style format, number of decimal places, and whether to display a comma or dollar 
sign for the numeric field or formula; then click the Save button. 
Note:  Additional decimal formats can be keyed directly into the Output Format field in order 
to print only a certain number of decimal places, unless a record includes a value containing 
additional decimal places (then it will print those additional decimal places for just that 
record).  For example, enter 0.0## in the Output Format field to print only one decimal place, 
unless a record contains more, then have it print up to three decimal places.  The additional 
format using #s for decimal places is not available to select but can be keyed into the field, if 
desired. 

 For booelan (true/false) fields or formulas - click in the field and click the button to specify 
the desired true/false style; then click the Save button. 

 Picture Alignment - located under the Appearance section and used to set the position of the 
image within the designated area of the object (image); must select TopLeft, TopRight, Center, 
BottomLeft, or BottomRight. 

 Rotation - located under the Appearance section and used to set the rotation (direction) of the 
lines for a barcode; must select None (for top to bottom), Rotate180Degrees (for bottom to top), 
Rotate90Degrees (for right to left), or Rotate270Degrees (for left to right). 

 Rounding Radius - located under the Appearance section and used to set the roundness of the 
corners if the shape type is set to RoundRect. 

 Size Mode - located under the Appearance section and used to set the size of the image within 
the designated area of the object (image); must select Clip, Stretch, or Zoom.  To use the 
actual size of the image, select Clip.  To have the image stretch to fill the designated area of the 
object (image), select Stretch.  To have the image zoom in to be the height of the designated 
area of the object (image), select Zoom. 

 Style - located under the Appearance section and used to set the shape type for a shape 
(Rectangle, Ellipse, or RoundRect) or to set the code type for a barcode. 

 Summary Func - located under the Data section and used to select the desired summary 
function or subtotal type for a numeric field or formula; must select Sum, Avg, Count, Min, Max, 
DCount, or None.  Typically, this field is only changed for a numeric field or formula located in a 
Footer section. 

 Vertical Alignment - located under the Appearance section; click in the field and click the down-
arrow button to set the vertical alignment of the text within a field, formula, or label; must select 
Top, Middle, or Bottom. 

4. The object will appear with the specified formatting; for example, the object will appear in boldface. 
5. Click the Save button. 
 
Moving Objects on a Report: 
Note:  The instructions below are for moving an object (field, formula, label, line, shape, image, barcode, 
or subreport) already inserted into a custom report. 
1. Click the object (field, formula, label, line, shape, image, barcode, or subreport) for which to move. 

Tip:  After an object is selected, handles (boxes) will appear around the outside edges of the 
selected object.  To select multiple objects to move at the same time, press and hold the Shift or 
Ctrl key and then select (click) all the desired items to move, or else click, drag, and drop a box 
(using your mouse) over all the desired objects.  To select all objects within a section, click the title 
bar for the section and then press the Ctrl+A keys. 
Note:  If the report to edit is not yet open, first complete the following:  from the Report Writer 
screen, click on the name of the view group in the Report Groups List that contains the report for 
which to move an object and click on the name of the report to edit in the Reports List (or click the 
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Find button instead to search for the desired report); then click the Edit Record button located at 
the top of the screen. 

2. To move the selected object using your mouse: 

 Place the cursor (pointer) on the object.  The pointer will change to a four-headed arrow when 
over the object. 

 Then click the object with the four-headed arrow and drag to the desired location. 

3. To move the selected object using the keyboard: 

 Press the right-arrow, left-arrow, up-arrow, or down-arrow key.  Depending on the option 
specified in the Grid Control Alignment field within the Report Writer Defaults option, the object 
will move as follows: 

Option Object Action 
Align to Grid Moves by one line (dot) on the grid 
Display Alignment Lines Moves to the nearest edge of the next closest object 
None Moves by one space 

Note:  If desired, hold the Ctrl key and then press the right-arrow, left-arrow, up-arrow, or 
down-arrow key to move the object by one space (applicable for all Grid Control Alignment 
options). 
Tip:  If the Shift key is pressed while pressing the arrow keys, the object will be resized instead 
of being moved.  Also, if the Ctrl key is pressed, clicking, dragging, and dropping the object will 
make a copy of the object. 

4. The selected object can also be moved using the following fields in the Properties List (located in the 
lower right corner of the screen): 

 X - located under the Layout section and used to set the exact position of the left edge of the 
object within the section using inches. 

 Y - located under the Layout section and used to set the exact position of the top edge of the 
object within the section using inches. 

5. Click the Save button. 
 
Aligning Objects on a Report: 
Note:  The instructions below are for aligning an object (field, formula, label, line, shape, image, 
barcode, or subreport) already inserted into a custom report (and the Group Footer/Header sections, if 
applicable). 
1. Click the object (field, formula, label, line, shape, image, barcode, or subreport) for which to align. 

Tip:  After an object is selected, handles (boxes) will appear around the outside edges of the 
selected object.  To select multiple objects to align at the same time, press and hold the Shift or Ctrl 
key and then select (click) all the desired items to align, or else click, drag, and drop a box (using 
your mouse) over all the desired objects.  To select all objects within a section, click the title bar for 
the section and then press the Ctrl+A keys. 
Note:  If the report to edit is not yet open, first complete the following:  from the Report Writer 
screen, click on the name of the view group in the Report Groups List that contains the report for 
which to align an object and click on the name of the report to edit in the Reports List (or click the 
Find button instead to search for the desired report); then click the Edit Record button located at 
the top of the screen. 

2. Click the applicable button, or select the Alignment menu and then the desired formatting option:   

 Align to Grid - to move an object to the nearest grid lines (dots) on a report. 

 Align Fields - to align multiple objects vertically and/or horizontally in relation to the first object 
selected.  After clicking the Align Fields button, select Lefts, Centers, Rights, Tops, Middles, 
or Bottoms to specify the desired alignment. 

 Make Same Size - to make the width and/or height of multiple objects the same as the first 
object selected.  After clicking the Make Same Size button, select Width, Height, or Both to 
specify which dimensions to change. 

 Horizontal Spacing - to adjust the horizontal spacing between multiple objects.  After clicking 
the Horizontal Spacing button, select Equal, Increase, Decrease, or Remove. 

 Vertical Spacing - to adjust the vertical spacing between multiple objects.  After clicking the 
Vertical Spacing button, select Equal, Increase, Decrease, or Remove. 
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 Align in Section - to align an object (or multiple objects) within the section.  After clicking the 
Align in Section button, select Left, Center, Right, Top, Middle, or Bottom. 

 Bring to Front - to move an object to the front of the stacking order with other objects. 

 Send to Back - to move an object to the bottom of the stacking order with other objects.   

 Move Group Up - to move the order of the selected Group Header or Group Footer section for 
a group up one position (with other groups) on the Edit Report screen.  

 Move Group Down - to move the order of the selected Group Header or Group Footer section 
for a group down one position (with other groups) on the Edit Report screen. 

 Fit To Page - to align all the objects on the report to fit on the page. 

 Adjust Header Fields - to align the standard header fields correctly within the Page Header 
section of the report. 

 Lock Controls - to lock all the objects on the Edit Report screen so they cannot be moved or 
resized.  Once the objects have been locked, the Lock Controls button displays as 
selected.  The objects will remain locked until the report is closed and reopened, or the Lock 
Controls button is clicked again. 

3. The object will move or change according to the particular aligning selections made. 
4. Click the Save button. 
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Report Settings 
 

The Report Settings option in the Report Writer module is used to define the overall settings for a 
custom report, such as the name of the report, margins, orientation, paper size, etc. 
 
Completing Report Settings: 
Note:  Below are the steps to complete the report settings screen while creating a new custom report in 
the Report Writer module. 
1. Enter a unique name for the report in the Report Name field.  The name can be alphanumeric and 

up to 255 characters long.  See Diagram A. 
2. Enter the appropriate type (Crosstab, Group By, or Select) for the report in the Report Type field, 

or click the down-arrow button to select the correct one.  To create a report in a grid format, enter 
Crosstab.  To create a report that will include a parameter on a formula which will determine what 
records to select (include on the report) after all other parameters are already completed, enter 
Group By.  To create a report for all other types of reports, enter Select.  The default of Select will 
appear, but can be changed if needed.  Typically, most reports are defined with a type of Select. 

3. In the Paper Size field, enter the desired size of the paper on which the report will print, or click the 
down-arrow button to select the correct one.  The default of Letter will appear, but can be changed.  
The selections available for the paper size are based on the paper sizes defined for the default 
printer. 

4. The measurements (in 
inches) for the selected 
paper size will display in the 
Width and Height fields.  If 
Custom is specified in the 
Paper Size field (only 
applicable with certain 
printers), the Width and 
Height fields are enabled 
and can be changed to set a 
custom paper size for the 
report. 

5. Enter the option (Collate, 
Don't Collate, or Printer 
Default) for collating the 
report in the Collate field, or 
click the down-arrow button 
to select the correct one.  To 
have the report printed in 
sets (page number order) if multiple copies are printed and the report is multiple pages 
long, enter Collate.  To have the report printed will all the copies of each page together (not 
collated), enter Don't Collate.  To have the report printed using the default setting for whether or not 
to collate from the printer preferences for the applicable printer, enter Printer Default.  The default 
of Printer Default (or other selection as designated in the Report Writer Defaults option) will appear, 
but can be changed. 

6. Enter the option (Horizontal, Printer Default, Simplex, or Vertical) for duplexing the report in the 
Duplex field, or click the down-arrow button to select the correct one.  To have the report printed on 
both sides of the paper using a horizontal page turn, enter Horizontal.  To have the report printed 
using the default setting for duplex from the printer preferences for the applicable printer, enter 
Printer Default.  To have the report printed on only one side of the paper (not duplexed), enter 
Simplex.  To have the report printed on both sides of the paper using a vertical page turn, enter 
Vertical.  The default of Printer Default (or other selection as designated in the Report Writer 
Defaults option) will appear, but can be changed. 

7. In the Paper Source field, enter the name of the paper source for which the report will print (for 
example, the paper tray from which the printer gets the paper to print the report), or click the down-
arrow button to select the correct one.  The default of Printer Default (or other selection as 
designated in the Report Writer Defaults option) will appear, but can be changed.  The selections 
available for the paper source are based on the paper sources defined for the default printer. 

8. Enter the desired page orientation (Portrait or Landscape) for the report in the Orientation field, or 
click the down-arrow button to select the correct one.  To print the report with the long edge of the 
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Typically, most reports are 
defined with a type of Select. 

In most cases, leave the 
Federal Form field unselected.  



paper down the side, enter Portrait.  To print the report with the long edge of the paper on the top 
and bottom, enter Landscape.  The default of Portrait will appear (unless Landscape is set as the 
default in the Report Writer Defaults option), but can be changed. 

9. In most cases, leave the Suppress Duplicate Detail Lines field unselected.  A checkmark will not 
appear in the box if the field is unselected. 
Note:  The Suppress Duplicate Detail Lines field should only be selected in special circumstances 
(when instructed by Customer Support) to suppress duplicate detail records on the report. 

10. In most cases, leave the Federal Form field unselected.  A checkmark will not appear in the box if 
the field is unselected. 
Note:  The Federal Form field should only be selected in special circumstances (when instructed by 
Customer Support). 

11. The Standard Report field will be disabled.  A checkmark will appear in the box if the report is a 
standard report. 

12. Enter the distance in inches from the top edge of the paper to where the information should start 
printing on the report in the Top Margin field.  The margin cannot be greater than 10 inches, but can 
be up to 5 digits long (including the decimal point) and will be rounded to 2 decimal places by the 
system if capable.  The default of 0.50 for one-half inch (or other specified margin as designated in 
the Report Writer Defaults option) will appear, but can be changed. 

13. Enter the distance in inches from the bottom edge of the paper to where the information should stop 
printing on the report in the Bottom Margin field.  The margin cannot be greater than 10 inches, but 
can be up to 5 digits long (including the decimal point) and will be rounded to 2 decimal places by 
the system if capable.  The default of 0.50 for one-half inch (or other specified margin as designated 
in the Report Writer Defaults option) will appear, but can be changed. 

14. Enter the distance in inches from the left edge of the paper to where the information should start 
printing on the report in the Left Margin field.  The margin cannot be greater than 10 inches, but can 
be up to 5 digits long (including the decimal point) and will be rounded to 2 decimal places by the 
system if capable.  The default of 0.50 for one-half inch (or other specified margin as designated in 
the Report Writer Defaults option) will appear, but can be changed. 

15. Enter the distance in inches from the right edge of the paper to where the information should stop 
printing on the report in the Right Margin field.  The margin cannot be greater than 10 inches, but 
can be up to 5 digits long (including the decimal point) and will be rounded to 2 decimal places by 
the system if capable.  The default of 0.50 for one-half inch (or other specified margin as designated 
in the Report Writer Defaults option) will appear, but can be changed. 

16. Click the Save button. 
 
Changing Report Settings: 
1. From the Report Writer screen, click on the name of the view group in the Report Groups List that 

contains the report for which to change the report settings and click on the name of the report to edit 
in the Reports List (or click the Find button instead to search for the desired report); then click the 
Edit Record button located at the top of the screen. 

2. On the Edit Report screen for the selected report, select the File menu and then Report Settings. 
3. Make the desired changes to the report settings. 

Note:  If a report was initially defined with a Report Type of Crosstab, the Report Type field will be 
disabled and cannot be changed.  If a report was initially defined with a Report Type of Group By or 
Select, the report cannot be changed to Crosstab as the Report Type. 

4. After all the changes have been made, click the Save button. 
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Categories/Screens 
 
The Categories/Screens option in Report Writer is used to define the report categories and screens 
within the School Accounting System where a report is listed (can be accessed).  
 
Defining Categories/Screens: 
Note:  Below are the steps to complete the categories/screens screen while creating a new custom 
report in the Report Writer module. 
1. In the Categories List, specify under which report categories to display the report by clicking the box 

for the Selected column to the left of each desired report category.  A checkmark will appear in the 
box if the report category is selected.  Only the report categories for the modules which the 
organization has licensed appear.  By default, the report categories applicable to the report group 
(query or view group) in which the report is built are automatically selected.  If desired, change the 
filters to modify the report categories displayed here.  The Categories List will be disabled if the 
report is created within one of the "PR State" report groups (for example, the "PR State IA 
Retirement" report group).  See Diagram A. 
Note:  If the Module ID field (column) is completed for a report category, the report will appear under 
the report category in that particular module; however, if the Module ID field is blank for a report 
category, the report will appear under the report category in the applicable module. 
Tip:  If a report has report selections, the default report selection can be set for the report category 
in the Report Selection field (column) by clicking the down-arrow button and selecting the desired 
one.  The System Relationship field (column) will display a checkmark in the box if a standard report 
was defined with the report category selected.  The User Category field (column) will display a 
checkmark in the box if the report category is one created from within the User Options option or 
User Security option for defining "favorite" reports for a user. 

2. In the Screens List, specify the screens within the School Accounting System for where to display 
the report by clicking the box for the Selected column to the left of each desired form (screen) 
description.  A checkmark will appear in the box if the screen is selected.  Only the screens within 
the modules which the organization has licensed appear.  By default, the screens applicable to the 
report group in which the report is built are automatically selected.  If desired, change the filters to 
modify the screens displayed here. 
Tip:  If a report has report selections, the default report selection can be set for the screen in the 
Report Selection field (column) by clicking the down-arrow button and selecting the desired 
one.  The System Relationship field (column) will display a checkmark in the box if a standard report 
was defined with the screen selected.  

3. Click the Save button. 

 
Changing Categories/Screens for a Report: 
1. From the Report Writer screen, click on the name of the view group in the Report Groups List that 

contains the report for which to change the categories/screens and click on the name of the report to 
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where to display the report. 



edit in the Reports List (or click the Find button instead to search for the desired report); then click 
the Edit Record button located at the top of the screen. 

2. On the Edit Report screen for the selected report, click the Categories/Screens button or select the 
Maintenance menu and then Categories/Screens. 

3. Make the desired changes to the categories/screens. 
a. To add the report to a report category or screen, click the box for the Selected column to the left 

of the desired report category or form name.  A checkmark will appear in the box if the item is 
selected. 

b. If the report has report selections, the default report selection can be set for each report 
category and/or screen in the Report Selection Description field (column) by clicking the down-
arrow button and selecting the desired one. 

c. To remove a report so that it no longer displays under the report category or screen, click the 
box for the Selected column to the left of the desired report category or form name to remove 
the checkmark. 
Note:  If a standard report was defined with the report category and/or screen selected, the 
System Relationship field (column) will display a checkmark in the box and the report category 
and/or screen cannot be unselected.  

4. After all the changes have been made, click the Save button. 
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Groups 
 
Groups are used to define how to sort the information printed on the report.  A group can be added to a 
report for a specific database field or formula.  For example, a group can be added to a report for an ID 
field in order to sort the data by IDs, or a group can be added for a description field in order to sort the 
data alphabetically by the description.  Multiple groups can be added to a report to have it sort the data 
different ways.  For example, multiple groups can be added to first sort by description and then sort by 
IDs. 
 
When adding a group to a report, the particular database field or formula on which to add the group is 
selected and then the Group Header and Group Footer sections are automatically included on the report 
for the specified field or formula.  As groups are added to a report, the sections appear on the screen as 
GroupHeader_##_ and GroupFooter_##_ (with ## reflecting the number of the group), followed by the 
name of the field or formula for which the group is defined.  For example, the first group will appear as 
GroupHeader_01_ and GroupFooter_01_, the second group will appear as GroupHeader_02_ and 
GroupFooter_02_, the third group as GroupHeader_03_ and GroupFooter_03_, etc.  The order the 
groups are listed with the assigned numbers is the order the groups will print (sort) the information on 
the actual report. 
 
Adding a Group: 
1. On the Edit Report screen for the selected report, select the Insert menu and then Group Header/

Footer. 
Note:  If the report to edit is not yet open, first complete the following:  from the Report Writer 
screen, click on the name of the view group in the Report Groups List that contains the report for 
which to add a group and click on the name of the report to edit in the Reports List (or click the Find 
button instead to search for the desired report); then click the Edit Record button located at the top 
of the screen. 

2. If the group will not be tied to a report selection, at the View Group Fields screen (see Diagram A), 
select the field for which to add the group.  To select a field, click the Fields tab, select the file that 
contains the field to insert by clicking once on the box (plus sign) in front of the file name or double-
clicking on the file name, and then double-click on the field name of the desired field.  To add a 
group on a formula instead, click the Formulas tab and then double-click on the formula name of 
the desired formula. 
Note:  The Group field (located at the top of the screen directly under the File menu) will default to 
New Group, and the Option field (located just to the right of the Group field) will default to No 
Option; in most cases, the defaults will be used for these fields when adding a group that is not tied 
to a report selection. 

3. If the group will be tied to a report selection, 
complete the following: 

 In the Group field (located at the top of 
the screen directly under the File menu), 
enter the appropriate group number to 
assign to the group, or click the down-
arrow button to select the correct one.  If 
the group should use a new group 
number that does not yet exist, enter 
New Group in the Group field; 
otherwise, enter the applicable group 
number (such as Group 1 or Group 2, 
etc.). 

 In the Option field (located just to the 
right of the Group field), enter the 
description of the desired report selection 
for which to add the group, or click the 
down-arrow button to select the correct 
one.  If the group is applicable to all the report selections (should not be 
tied to a specific report selection), enter No Option in the Option field. 
Note:  If a group is tied to a report selection, the group is only used for sorting the data on the 
report if the report selection it is tied to is selected when generating the report. If a group is not 
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tied to a report selection, the group will always be used for sorting no matter what report 
selection is selected when generating the report. 
Tip:  A group can have the same group number as another group but be tied to different report 
selection in the Option field.  For example, a group can be added for Group 3 that is tied to a 
report selection of Posted, while another group can also have a Group 3 tied to a report 
selection of Unposted.  On the Edit Report screen, the group that is tied to the first report 
selection would appear as GroupHeader_03_01_ and GroupFooter_03_01_, while the group 
that is tied to the second report selection would appear as GroupHeader_03_02_ and 
GroupFooter_03_02_.  Keep in mind, the number of a report selection is defined when the 
report selection is set up. 

 Select the field for which to add the group.  To select a field, click the Fields tab, select the file 
that contains the field to insert by clicking once on the box (plus sign) in front of the file name or 
double-clicking on the file name, and then double-click on the field name of the desired field.  To 
add a group on a formula instead, click the Formulas tab and then double-click on the formula 
name of the desired formula. 

4. The Group Header and Group Footer sections are automatically included on the report for the 
specified field or formula.  See Diagram B.  Edit the sections as desired by inserting database 
fields, formulas, labels, lines, shapes, images, subreports, or barcodes into the Group Header and 
Group Footer sections, and then format and align the items (objects) as needed.  Also, utilize the 
Properties List (located in the lower right corner of the screen) to change the defined properties for 
the Group Header and Group Footer sections, if desired. 
Note:  By default, the group will be added to sort the data in ascending order for the specified field 
or formula, but the order can be changed to descending.  To change the sort order for the group, 
first click the title bar for the Group Header section and then select the desired option (Ascending or 
Descending) in the Sort field under the Data section in the Properties List. 
Tip:  If a group is added just to sort the data alphabetically or numerically, be sure to suppress the 
Group Header and Group Footer sections.  To suppress the Group Header or Group Footer section, 
first click the title bar for the desired section and then select False in the Visible field under the 
Behavior section in the Properties List. 

5. Click the Save button to save the report with the newly added group. 

 
Changing a Group: 
1. On the Edit Report screen for the selected report, select the Group Header or Group Footer for the 

group to edit by clicking the title bar for the section. 
Note:  If the report to edit is not yet open, first complete the following:  from the Report Writer 
screen, click on the name of the view group in the Report Groups List that contains the report for 
which to edit the group and click on the name of the report to edit in the Reports List (or click the 
Find button instead to search for the desired report); then click the Edit Record button located at 
the top of the screen. 

2. Using the Properties List located in the lower right corner of the Edit Report screen, make the 
desired changes for the group. 
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After inserting a group into a report, the Group Header and 
Group Footer sections for the selected field or formula 
automatically appear on the Edit Report screen.  In this example, 
a group was added to sort the data alphabetically by name. 

Since the group was added to just sort the data alphabetically, 
the Group Header and Group Footer sections were suppressed 
by selecting False in the Visible field in the Properties List. 



 To suppress a section so that it does not print, click the title bar for the desired section and then 
select False in the Visible field under the Behavior section in the Properties List. 

 To change the sort order for the group, click the title bar for the Group Header section and then 
select the desired option (Ascending or Descending) in the Sort field under the Data section in 
the Properties List. 

 To have a new page inserted before and/or after the section, click the title bar for the desired 
section and then select the desired option  (None, Before, After, or BeforeAfter) in the New 
Page field under the Data section in the Properties List.   

 To change the field (or formula) used for the group, click the title bar for the Group Header 
section and then click the down-arrow button in the Data Field field under the Data section in 
the Properties List to select the desired field for which to have the data grouped (sorted). 

3. After all the changes have been made, click the Save button. 
 
Deleting a Group: 
1. On the Edit Report screen for for the selected report, select the Group Header for the group to 

delete by clicking the title bar for the section. 
Note:  If the report to edit is not yet open, first complete the following:  from the Report Writer 
screen, click on the name of the view group in the Report Groups List that contains the report for 
which to edit the group and click on the name of the report to edit in the Reports List (or click the 
Find button instead to search for the desired report); then click the Edit Record button located at 
the top of the screen. 

2. With the mouse pointer on the section title bar, right-click and select Delete. 
3. When prompted to delete both the header and the footer for the selected group, click Yes. 
4. Click the Save button to save the changes to the report. 
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Filter Records 
 

The Filter Records option in Report Writer (and the Flexible Financial Report Setup option in General 
Ledger) is used to add a custom filter (selection formula) to a report in order to print only certain records.  
The record must match the criteria in the filter records formula in order to be included on the report.  If 
the filter records formula is blank, all records will print on the report. 
 
Adding a Filter Record: 
1. Click the Filter Records button. 

Note:  If the report to edit is not yet open, first complete the following:  from the Report Writer 
screen, click on the name of the view group in the Report Groups List that contains the report for 
which to add a filter records formula and click on the name of the report to edit in the Reports List (or 
click the Find button instead to search for the desired report); then click the Edit Record button 
located at the top of the screen.  If adding a filter records formula to a flexible financial report, select 
the Maintenance menu from the General Ledger screen and then Flexible Financial Report 
Setup; then bring up the desired report for which to add the filter records formula. 

2. Create the filter records formula by including fields, values, operators, and text in the filter (formula).  
See Diagram A. 

3. To include a field (from 
your database) in the 
filter records formula, 
click the Fields tab in 
the upper-left corner of 
the screen, select the 
file that contains the 
field to insert by clicking 
once on the box (plus 
sign) in front of the file 
name or double-clicking 
on the file name, and 
then double-click on the 
field name of the 
desired field. 

4. To use an operator in 
the filter records formula, either key the operator or select the operator from the 
Operators List by double-clicking on the desired operator. 

5. To include a value in the filter records formula, simply key the value. 
6. To include text in the filter records formula, key the text and then be sure to enclose the text in 

apostrophes (‘). 
7. After the filter records formula is entered, click the Check Formula button to have the system check 

the formula for errors. 
8. A message will appear in the status bar stating if there are any errors in the formula or if the formula 

was validated. 
Note:  If there is an error, be sure to correct the error before continuing. 

9. Click the Save button to save the filter records formula. 
 
Changing a Filter Record: 
1. Click the Filter Records button. 

Note:  If the report to edit is not yet open, first complete the following:  from the Report Writer 
screen, click on the name of the view group in the Report Groups List that contains the report for 
which to change the filter records formula and click on the name of the report to edit in the Reports 
List (or click the Find button instead to search for the desired report); then click the Edit Record 
button located at the top of the screen.  If changing a filter records formula for a flexible financial 
report, select the Maintenance menu from the General Ledger screen and then Flexible Financial 
Report Setup; then bring up the desired report for which to change the filter records formula. 

2. Make the desired changes to the filter records formula. 
3. Click the Check Formula button to have the system check the formula for errors. 
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In this example, only active vendors 
will be included on the report. 

After the filter records formula is entered, 
click the Check Formula button to have 
the system check the formula for errors. 



4. A message will appear in the status bar stating if there are any errors in the formula or if the formula 
was validated. 
Note:  If there is an error, be sure to correct the error before continuing. 

5. Click the Save button to save the changes to the filter records formula. 
 
Sample Filter Records Formulas: 
Below is a list of examples that you can use when adding a new filter records formula. 
Formula 1:  [vfaBuildings].[BuildingID] = 'HS' 
Result:  All assets with a Building ID of HS 
Formula 2:  [vapInvoiceDetails].[Vendor1099Amount] >= 600 
Result:  All vendors with a YTD 1099 amount of $600 or greater 
Formula 3:  [vprEmployees].[SalaryType] = 'U' AND [vprEmployeeWages].[PayRate] > 7.25 
Result:  All employees with a Salary Type of Unit and a Pay Rate greater than $7.25 
Formula 4:  [vfaBuildings].[BuildingID] = 'ELEM' OR [vfaBuildings].[BuildingID] = 'MS' 
Result:  All assets with a Building ID of ELEM or MS 
Formula 5:  [vapVendors].[VendorDescription] LIKE 'Text%' 
Result:  All vendors with a description that starts with Text 
Formula 6:  [vprPayees].[DirectDeposit] = 'True' 
Or Formula 6:  [vprPayees].[DirectDeposit] = 1 
Result:  All payees whose payments are made through direct deposit 
Formula 7:  [vglAccountTypes].[AccountTypeCode] = '8' 
Result:  All account numbers with an Account Type of 8 for revenues 
Formula 8:  [vfaAssets].[TotalCost] >= 750 
Result:  All assets with a Total Cost of $750 or greater 
Formula 9:  [vprEmployeeWages].[Step] = 2 AND [vprEmployeeWages].[Lane] = 3 
Result:  All employees with pay codes where the step is equal to 2 and the lane is equal to 3 
Formula 10:  [vprEmployees].[HireRehireDateLatest] >= '01/01/2011' 
Result:  All employees with a Hire/Rehire Date (or most recent Hire/Rehire Date if multiple hire/rehire 
dates are entered) of January 1, 2011 and later 
Formula 11:  [vapVendors].[LastCheckDate] = '11/15/2010' 
Result:  All vendors with a Last Check Date equal to November 15, 2010 
Formula 12:  [vglChartOfAccounts].[AccountTypeID] IN ('8', '9') 
Result:  All account numbers with an Account Type of 8 or 9 for revenues and expenditures 
Formula 13:  [vglChartOfAccounts].[AccountTypeID] NOT IN ('8', '9') 
Result:  All balance sheet account numbers (those with an Account Type excluding 8 and 9) 
Formula 14:  [vfaAssets].[TotalCost] BETWEEN 750 AND 2000 
Result:  All assets with a Total Cost equal to and between $750 and $2000 
Formula 15:  [vglChartOfAccountParts].[FunctionNumber] BETWEEN '2000' AND '2999' 
Result:  All account numbers with a function in the 2000s 
Formula 16:  [vfaAssets].[PurchaseDate] BETWEEN '07/01/2011' AND '06/30/2012' 
Result:  All assets with a Purchase Date on or after 07/01/2011 but on or before 06/30/2012 
Formula 17:  [vglChartOfAccountParts].[FunctionNumber] NOT BETWEEN '2000' AND '2999' 
Result:  All account numbers with a function below and above the 2000s 
Formula 18:  [vfaAssets].[PurchaseDate] NOT BETWEEN '07/01/2011' AND '06/30/2012' 
Result:  All assets with a Purchase Date before 07/01/2011 and after 06/30/2012 
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Formulas 
 

The Formulas option in Report Writer is used to create formulas to include on reports, and change or 
delete formulas.  Within the Formulas option, formulas can be created to do a number of functions, 
including the following:  1) add, subtract, multiply, and divide fields (for example, multiply the quantity 
field by the unit price field to determine the total cost of an item); 2) combine two or more fields into one 
(for example, combine the first and last name fields into one for the full name); 3) compare an 
expression in order to determine the result (for example, if a certain field is true for a record then print 
one phrase or else if it is false print a different phrase); and 4) change the format of field (for example, 
change the text in a field to all uppercase).  Formulas can be as simple or as complex as needed. 
 
Once a formula is created for one report, the same formula can be accessed and included on other 
applicable reports (those built in view groups containing the fields included in the formula). 
 
Adding a Formula: 
1. On the Edit Report screen for the selected report, click the Formulas button or select the 

Maintenance menu and then Formulas. 
Note:  If the report to edit is not yet open, first complete the following:  from the Report Writer 
screen, click on the name of the view group in the Report Groups List that contains the report for 
which to add a formula and click on the name of the report to edit in the Reports List (or click the 
Find button instead to search for the desired report); then click the Edit Record button located at 
the top of the screen. 

2. At the Formulas screen, click the New Record button. 
3. Enter a unique name for the formula in the Formula Name field.  The name can be alphanumeric 

and up to 50 characters long (no spaces).  See Diagram A. 
4. If desired, enter a longer description for the formula in the Formula Heading field.  The description 

can be up to 100 characters long. 
5. If desired, enter a comment for the formula in the Formula Description field.  The comment can be 

up to 1,000 characters long. 
6. Enter the appropriate field type (Boolean, Date, Decimal, Integer, Month, Percent, or Text) for the 

result of the formula in the Data Type field, or click the down-arrow button to select the correct one.  
If the result of the formula will be a true/false field, enter Boolean.  If the result of the formula will be 
a date field, enter Date.  If the result of the formula will be a decimal field (numeric field with 
decimals), enter Decimal.  If the result of the formula will be an integer field (numeric field with no 
decimals), enter Integer.  If the result of the formula will be a month field, enter Month.  If the result 
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Diagram A 

Select the appropriate field type (Boolean, Date, Decimal, 
Integer, Month, Percent, or Text) for the result of the formula.  

After the formula is entered, click the 
Check Formula button to have the 
system check the formula for errors. 



of the formula will be a percent field, enter Percent.  If the result of the formula will be a text field, 
enter Text. 

7. In the Formula Width field, enter the number of characters to use as the default width for the formula 
(field) when added to a new report.  The number for the width can be up to 3 digits long.  The default 
number as based on the selected Data Type will appear, but can be changed. 

8. The System Formula field is disabled and cannot be changed.  A checkmark will only appear in the 
box if the formula is a standard one created by Software Unlimited, Inc. 

9. Create the formula by including fields, values, operators, and text in the formula. 
10. To include a field (from your database) in the formula, click the Fields tab in the middle left side of 

the screen, select the file that contains the field to insert by clicking once on the box (plus sign) in 
front of the file name or double-clicking on the file name, and then double-click on the field name of 
the desired field. 

11. To use an operator in the formula, either key the operator or select the operator from the Operators 
List by double-clicking on the desired operator. 

12. To include a value in the formula, simply key the value. 
13. To include text in the formula, key the text and then be sure to enclose the text in apostrophes (‘). 
14. After the formula is entered, click the Check Formula button to have the system check the formula 

for errors. 
15. A message will appear in the status bar stating if there are any errors in the formula or if the formula 

was validated. 
Note:  If there is an error, be sure to correct the error before continuing. 

16. Click the Save button to save the formula. 
17. When finished adding all desired formulas, click the X in the upper right-hand corner to return to the 

Edit Report screen. 
 
Changing a Formula: 
Note:  Standard formulas (those with the System Formula field selected) cannot be changed. 
1. On the Edit Report screen for the selected report, click the Formulas button or select the 

Maintenance menu and then Formulas. 
Note:  If the report to edit is not yet open, first complete the following:  from the Report Writer 
screen, click on the name of the view group in the Report Groups List that contains the report with 
the formula to change and click on the name of the report to edit in the Reports List (or click the 
Find button instead to search for the desired report); then click the Edit Record button located at 
the top of the screen. 

2. At the Formulas screen, enter the name of the formula to change in the Formula Name field.  If the 
name is not known, click the down-arrow button or the Find button to select the correct one. 

3. Make the desired changes to the formula. 
4. Click the Check Formula button to have the system check the formula for errors. 
5. A message will appear in the status bar stating if there are any errors in the formula or if the formula 

was validated. 
Note:  If there is an error, be sure to correct the error before continuing. 

6. Click the Save button to save the changes to the formula. 
7. If the Formula Name was changed, a prompt will appear verifying whether or not to change the 

name of the formula or add a new formula.  To change the name of the formula, click the Change 
button.  To not change the name and revert to use the original name, click the Revert to Original 
button.  To add a new formula with the specified name that is a duplicate of the current formula, click 
the Create New button. 

8. Click the X in the upper right-hand corner to return to the Edit Report screen. 
 
Deleting a Formula: 
Note:  Standard formulas (those with the System Formula field selected) cannot be deleted.  Also, a 
formula can only be deleted if the formula is not currently used in a report. 
1. On the Edit Report screen for the selected report, delete the formula from the report, if needed, and 

save the report by clicking the Save button. 
Note:  If the report to edit is not yet open, first complete the following:  from the Report Writer 
screen, click on the name of the view group in the Report Groups List that contains the report with 
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the formula to delete and click on the name of the report to edit in the Reports List (or click the Find 
button instead to search for the desired report); then click the Edit Record button located at the top 
of the screen. 

2. Then click the Formulas button or select the Maintenance menu and then Formulas. 
3. At the Formulas screen, enter the name of the formula to delete in the Formula Name field.  If the 

name is not known, click the down-arrow button or the Find button to select the correct one. 
4. Once the formula to delete is displayed on the screen, click the Delete button; when prompted to 

delete the record, click Yes. 
5. Click the X in the upper right-hand corner to return to the Edit Report screen. 
 
Sample Formulas: 
Below is a list of examples that you can use when adding a new formula. 
Formula 1:  [vprEmployees].[FirstName] + ' ' + [vprEmployees].[LastName] 
Result:  One field displaying the employee’s first name, a space, and then the employee’s last name 
Formula 2:  [vfaAssets].[UnitCost] * [vfaAssets].[Quantity] 
Result:  Unit cost multiplied by quantity to calculate total cost (asset value) 
Formula 3:  ([vfaAssets].[TotalCost] - [vfaAssets].[SalvageValue]) / [vfaAssets].[UsefulLife] 
Result:  Total cost less the salvage value divided by the number of years of useful life to calculate the 
depreciated amount per year for an asset 
Formula 4:  LEFT([vprEmployees].[MiddleName], 1) 
Result:  An employee’s middle initial (first character from the left part of the field) 
Formula 5:  RIGHT([vprEmployees].[LastName], 4) 
Result:  Last four characters of an employee’s last name (last four characters from the right part of the 
field) 
Formula 6:  SUBSTRING([vprEmployees].[LastName], 4, 3) 
Result:  Three characters of an employee’s last name starting with the fourth character 
Formula 7:  UPPER([vprEmployees].[LastName]) 
Result:  An employee’s last name in all uppercase even though it may have been keyed in upper- and 
lowercase letters 
Formula 8:  LOWER([vprEmployees].[LastName]) 
Result:  An employee’s last name in all lowercase even though it may have been keyed in upper- and 
lowercase letters 
Formula 9:  LEN([vprEmployees].[LastName]) 
Result:  Number of characters of an employee’s last name 
Formula 10:  YEAR([vfaAssets].[PurchaseDate]) 
Result:  Year when an asset was purchased 
Formula 11:  MONTH([vfaAssets].[PurchaseDate]) 
Result:  Month when an asset was purchased 
Formula 12:  DAY([vfaAssets].[PurchaseDate]) 
Result:  Day when an asset was purchased 
Formula 13:  FORMAT([vapVendors].[LastCheckDate], ‘MMMM’) 
Result:  Month (in words) of the last check date for a vendor 
Formula 14:  CASE WHEN [vprEmployees].[EmployeeStatus] = 'Terminated' THEN [vprEmployees].
[TerminationDateLatest] ELSE NULL END 
Result:  If an employee has an Employee Status of terminated, the latest termination date will print; 
otherwise, will be blank 
Tip:  This formula would be defined with Date as the Data Type. 
Formula 15:  CASE WHEN [vprEmployees].[EmployeeStatus] = 'Terminated' THEN CONVERT
(VARCHAR, [vprEmployees].[TerminationDateLatest], 101) ELSE 'N/A' END 
Result:  If an employee has an Employee Status of terminated, the latest termination date will print 
(using the format of mm/dd/yyyy); otherwise, N/A will print 
Tip:  This formula would be defined with Text as the Data Type. 
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Formula 16:  CASE [vprEmployees].[EmployeeStatus] WHEN 'Terminated' THEN 'Terminated 
On '+CONVERT(VARCHAR, [vprEmployees].[TerminationDateLatest], 101) WHEN 'Retired' 
Then 'Retired On '+CONVERT(VARCHAR, [vprEmployees].[TerminationDateLatest], 101) 
ELSE 'Not Applicable' END 
Result:  If an employee has an Employee Status of terminated, Terminated On followed 
by the latest termination date will print (using the format of mm/dd/yyyy); or if 
an employee has an Employee Status of retired, Retired On followed by the latest 
termination date will print (using the format of mm/dd/yyyy); otherwise, Not Applicable 
will print 
Tip:  This formula would be defined with Text as the Data Type. 
Formula 17:  DATEDIFF(YEAR, [vfaAssets].[PurchaseDate], CONVERT(DATE,'07/01/2001')) 
Result:  Number of years the district has had the asset as of July 1, 2001 
Formula 18:  DATEDIFF(YEAR, [vfaAssets].[PurchaseDate], GETDATE()) 
Result:  Number of years the district has had the asset as of the current date (based on the current date 
set on the computer) 
Formula 19:  DATEDIFF(MONTH, [vfaAssets].[PurchaseDate], CONVERT(DATE,'07/01/2001')) 
Result:  Number of months the district has had the asset as of July 1, 2001 
Formula 20:  (DATEDIFF(MONTH, [vfaAssets].[PurchaseDate], CONVERT(DATE,'07/01/2001')))/12.00 
Result:  Number of years and months the district has had the asset as of July 1, 2001 
Formula 21:  DATEDIFF(DAY, [vfaAssets].[PurchaseDate], CONVERT(DATE,'07/01/2001')) 
Result:  Number of days the district has had the asset as of July 1, 2001 
Formula 22:  DATEADD(YEAR, 2, [vfaAssets].[PurchaseDate]) 
Result:  A date equaling the purchase date of an asset plus two years 
Formula 23:  DATEADD(MONTH, 6, [vfaAssets].[PurchaseDate]) 
Result:  A date equaling the purchase date of an asset plus six months 
Formula 24:  DATEADD(DAY, 20, [vfaAssets].[PurchaseDate]) 
Result:  A date equaling the purchase date of an asset plus 20 days 
Formula 25:  DATEADD(YEAR, 1, GETDATE()) 
Result:  A date equaling one year from the current date (based on the current date set on the computer) 
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Report Parameters 
 

The Report Parameters option in Report Writer is used to add parameters to a report; parameters are 
then used to select the records that print on a report at the time the report is printed.  For example, a 
report may include a parameter for Months, and then at the time the report is printed, a user can select 
the desired months to include on the report 
 
Adding a Report Parameter: 
1. On the Edit Report screen for the selected report, click the Report Parameters button or select the 

Maintenance menu and then Report Parameters. 
Note:  If the report to edit is not yet open, first complete the following:  from the Report Writer 
screen, click on the name of the view group in the Report Groups List that contains the report for 
which to add a report parameter and click on the name of the report to edit in the Reports List (or 
click the Find button instead to search for the desired report); then click the Edit Record button 
located at the top of the screen. 

2. At the Report Parameters screen, click the New Record button. 
3. Enter the field or formula for which to add the parameter in the Field Name field, or click the 

Directory button to select the desired one.  See Diagram A. 

4. In the Parameter Caption field, enter the description to use as the parameter label on 
the Report Printing Options screen.  The description can be up to 100 characters long. 

5. If desired, enter the same field for which the parameter is being added in the Parameter Type field 
(or click the down-arrow button to select the desired field) to have a selection automatically passed 
in for the parameter when generating the report.  The parameter will only be passed in if the report is 
generated from within the applicable option, and the record or batch currently displayed will be what 
is selected for the parameter.  For example, if a parameter is being added to a report for the 
Employee ID field, enter Employee ID as the Parameter Type; then when the report is generated 
from within the Employee File (or other applicable option), the employee currently displayed on the 
screen will be selected automatically.  Leave the field blank to not automatically select a record for 
the parameter. 
Note:  The Parameter Type field is only available for certain fields; to view the list of fields available 
for use with the Parameter Type field, click the down-arrow button (or press the Ctrl+F keys) and 
change the filter for the Data Type field (column) to show All. 

6. If the parameter should be grouped (combined) with another parameter when generating the report 
using an 'or' operator (instead of the typical 'and' operator), enter the appropriate 1-digit group 
number to use for the parameter in the Or Group Number field.  For example, if there is a set of 
parameters that should be grouped together using the 'or' operator, enter 1 in this field for the 
applicable parameters; or if there are two sets of parameters that should be grouped together, enter 
1 in this field for the applicable  parameters in the first set and 2 for the parameters in the second 
set.  In most cases, this field will be left blank to use the 'and' operator in conjunction with 
other parameters.  
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In this example, the StateProvinceCode, City, and 
NameLastFirstMiddleLegalBusiness fields (in addition to the 
Vendor ID field) will appear for each record when clicking the 
Search button for this parameter when generating the report. 



Tip:  When parameters have this field completed, a record only has to meet the criteria for one of 
the parameters in the specified group in order to be included on the report; whereas normally, a 
record would have to meet the criteria selected for all the parameters in order to be printed on the 
report. 

7. If applicable, select the Select by Sum field to omit the Search button from displaying for the 
parameter when generating the report.  A checkmark will appear in the box if the field is selected.   
Note:  This field is only enabled if the Report Type for the report is Group By (as defined within the 
report settings) and the field for which the parameter is being added is a numeric field. 

8. If applicable, all the report selections defined for the report appear in the Report Selection List 
(under the Select by Sum field).  To tie the parameter to one or more of the existing report 
selections, click the box for the Selected column to the left of each desired report selection 
description.  A checkmark will appear in the box if the report selection is selected. If a parameter is 
tied to a report selection, the parameter will appear on the Report Printing Options screen when 
generating the report for the particular report selection.  By default, all report selections will be 
selected, but can be changed if needed.  

9. To have additional fields of information appear for each record when clicking the Search button for 
this parameter (when printing the report), enter the number for the order in which to display the 
desired fields in the Field Sequence field (column) in the Additional Fields to Display List.  For 
example, if a parameter is being added to the report for the Employee ID field and the first and last 
names for the employees should also display with the IDs when clicking the Search button for the 
Employee ID parameter, enter 1 under the Field Sequence field (column) for First Name and enter 2 
for Last Name. 

10. Click the Save button. 
11. When finished adding all desired parameters, click the X in the upper right-hand corner to return to 

the Edit Report screen. 
 
Changing a Report Parameter: 
1. On the Edit Report screen for the selected report, click the Report Parameters button or select the 

Maintenance menu and then Report Parameters. 
Note:  If the report to edit is not yet open, first complete the following:  from the Report Writer 
screen, click on the name of the view group in the Report Groups List that contains the report for 
which to edit the report parameter and click on the name of the report to edit in the Reports List (or 
click the Find button instead to search for the desired report); then click the Edit Record button 
located at the top of the screen. 

2. At the Report Parameters screen, double-click on the desired parameter to edit in the Report 
Parameters List, or click the Find button to select the correct one. 

3. Make the desired changes to the parameter. 
4. After all the changes have been made, click the Save button. 
 
Deleting a Report Parameter: 
1. On the Edit Report screen for the selected report, click the Report Parameters button or select the 

Maintenance menu and then Report Parameters. 
Note:  If the report to edit is not yet open, first complete the following:  from the Report Writer 
screen, click on the name of the view group in the Report Groups List that contains the report for 
which to delete the report parameter and click on the name of the report to edit in the Reports List 
(or click the Find button instead to search for the desired report); then click the Edit Record button 
located at the top of the screen. 

2. At the Report Parameters screen, double-click on the desired parameter to delete in the Report 
Parameters List, or click the Find button to select the correct one. 

3. Once the parameter to delete is displayed on the screen, click the Delete button; when prompted to 
delete the record, click Yes. 

14-b 



MISCELLANEOUS 
 

Report Wizard ................................................................................................ 15 
Crosstab Reports .......................................................................................... 16 
Export Reports and Import Reports ............................................................ 17 
 



Report Wizard 
 

The Report Wizard option is available in Report Writer to create a custom report using a simpler method 
rather than the normal Edit Report screen.  The screens used with the Report Wizard option are similar 
to those found in the Flexible Financial Report Setup option and Board Report Setup option. 
 
With the Report Wizard option, reports can only be created from scratch; the Report Wizard option 
cannot be used to edit existing custom reports.  When creating a report with the Report Wizard option, 
the report is created with Select as the Report Type (reports with a Report Type of Crosstab or Group 
By must be created using the normal method, not the Report Wizard).  
 
Adding a Custom Report Using Report Wizard: 
1. From the Report Writer screen, select the report group (query or view group) for which to add the 

new custom report by clicking on the name of the view group in the Report Groups List. 
Tip:  If desired, click the Directory button after clicking on a report group to view a list of the files 
from which fields can be included on a report in the particular report group. 

2. Click the Report Wizard button located at the top of the screen to create a new report in the 
selected report group using the report wizard.  See Diagram A. 

3. On the Report Wizard screen, click the General tab to complete the general 
information and settings for the new report.  See Diagram B. 

 Enter a unique name for the report in the Report Name field.  The name can be alphanumeric 
and up to 255 characters long. 

 Complete the Page Settings section for the report: 

 Enter the desired page orientation (Portrait or Landscape) for the new report in the 
Orientation field, or click the down-arrow button to select the correct one.  To print the 
report with the long edge of the paper down the side, enter Portrait.  To print the report with 
the long edge of the paper on the top and bottom, enter Landscape.  The default of 
Portrait will appear (unless Landscape is set as the default in the Report Writer Defaults 
option if the district has the Report Writer module), but can be changed. 

 Enter the distance in inches from the top edge of the paper to where the information should 
start printing on the report in the Top Margin field.  The margin cannot be greater than 2 
inches, but can be up to 4 digits long (including the decimal point) and will be rounded to 2 
decimal places by the system if capable.  The default of 0.50 for one-half inch (or other 
specified margin as designated in the Report Writer Defaults option if the district has the 
Report Writer module) will appear, but can be changed. 

 Enter the distance in inches from the bottom edge of the paper to where the information 
should stop printing on the report in the Bottom Margin field.  The margin cannot be greater 
than 2 inches, but can be up to 4 digits long (including the decimal point) and will be 
rounded to 2 decimal places by the system if capable.  The default of 0.50 for one-half inch 
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To add a new custom report using the Report 
Wizard, select the desired report group and 
then click the Report Wizard button. 



(or other specified margin as designated in the Report Writer Defaults option if the district 
has the Report Writer module) will appear, but can be changed. 

 Enter the distance in inches from the left edge of the paper to where the information should 
start printing on the report in the Left Margin field.  The margin cannot be greater than 2 
inches, but can be up to 4 digits long (including the decimal point) and will be rounded to 2 
decimal places by the system if capable.  The default of 0.50 for one-half inch (or other 
specified margin as designated in the Report Writer Defaults option if the district has the 
Report Writer module) will appear, but can be changed. 

 Enter the distance in inches from the right edge of the paper to where the information 
should stop printing on the report in the Right Margin field.  The margin cannot be greater 
than 2 inches, but can be up to 4 digits long (including the decimal point) and will be 
rounded to 2 decimal places by the system if capable.  The default of 0.50 for one-half inch 
(or other specified margin as designated in the Report Writer Defaults option if the district 
has the Report Writer module) will appear, but can be changed. 

 Select the Grand Total field to have grand totals print on the last page for the numeric fields 
included on the report.  A checkmark will appear in the box if the field is selected. 

 If the total of all the field widths included on the report is greater than the actual length available 
for one line (row) on the report, select the Auto Adjust Fields field to have the system 
automatically resize (decrease) all the field widths when the report is generated so that all fields 
will print on one line (otherwise, if not selected, fields will print on multiple lines).  A checkmark 
will appear in the box if the field is selected.   
Note:  If this field is selected for the report and the data in a particular field is longer than the 
resized field width, the information in the field will be wrapped to multiple lines when the report is 
printed. 

 Select the font, font style, and font size to use for the information printed in the Group Header 
section(s) on the report by clicking the Search button for the Group Header Font field.  After 
selecting the desired font information, click the OK button and the selected font will appear in 
this field.  The default of Arial, Regular, font size 8 (or other specified font as designated in the 
Report Writer Defaults option if the district has the Report Writer module) will appear, but can be 
changed. 

 Select the font, font style, and font size to use for the information printed in the Detail, Group 
Footer, and Page Footer sections on the report (and the column headings printed in the Page 
Header section, if applicable) by clicking the Search button for the Detail Font field.  After 
selecting the desired font information, click the OK button and the selected font will appear in 
this field.  The default of Arial, Regular, font size 8 (or other specified font as designated in the 
Report Writer Defaults option if the district has the Report Writer module) will appear, but can be 
changed. 

4. Click the Field Selection tab to select the fields of information to include in the Detail section on the 
report.  See Diagram C. 
Note:  To add fields of information to a Group section, refer to Step 5 below. 
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On the General tab, complete the 
general settings for the new report 
including the report name and margins. 



 Select the fields (columns) of information to include in the Detail section on 
the report by double-clicking on the desired fields in the list on the left side of the screen.  As the 
fields are added to the report, the fields will appear under the Detail section in the Report Layout 
List on the right side of the screen. 
Note:  To remove a field from the report, click the Delete button located to the left of the desired 
field; when prompted to delete the line, click Yes. 

 The order the fields are listed on the screen under the Detail section in the Report Layout List is 
the order the fields (columns) will print on the actual report.  If desired, to change the order of 
the fields, click once on the field to move and then click the Top, Up, Down, or Bottom button 
until the field is in the desired position. 

 Define the settings for each field included in the Detail section on the report as follows: 

 Enter the heading description to print for the field (column) on the report in the Label field, or 
leave the field blank to omit the heading, if desired.  The description can be alphanumeric 
and up to 128 characters long.  A default heading description for the field will appear, but 
can be changed. 

 Enter the number of characters for how wide to print the field (column) on the report in the 
Field Width field.  The number for the width can be up to 3 digits long.  A default width for 
the field will appear, but can be changed. 

 The name of the field (column) to print on the report appears in the Field Name field and 
cannot be changed. 

 The Display in Section Header and Display in Section Footer fields appear but are disabled 
as they are not applicable for fields in the Detail section. 

 Define the settings for the Detail section as follows: 

 Detail appears in the Section Name field and cannot be changed. 

 The Group By field appears but is disabled as it is not applicable for the Detail section. 

 Enter the desired option for printing the Detail section (Hide Section, Display Section with 
No Labels, Display Section with Page Labels, or Display Section with Section Labels) 
in the Header Properties field, or click the down-arrow button to select the correct one.  To 
not print the Detail section (or any of the fields in the Detail section), enter Hide 
Section.  To print the fields in the Detail section without printing any headings (labels) for 
the fields, enter Display Section with No Labels.  To print the fields in the Detail section 
and the headings (labels) for the fields in the Page Header section as column headings, 
enter Display Section with Page Labels.  To print the fields and headings (labels) for the 
fields in the Detail section in order to have the heading (label) print right before (to the left 
of) the field, enter Display Section with Section Labels.  The default of Display Section 
with Page Labels will appear, but can be changed. 

 The Footer Properties field appears but is disabled as it is not applicable for the Detail 
section. 

 The New Page After field appears but is disabled as it is not applicable for the Detail 
section. 
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Diagram C 

Click the Field Selection tab 
to add fields to the new report. 

To add a field, double-click the field in the list on the left side of the screen.  As the fields are 
added to the report, they will appear under the Detail section on the right side of the screen. 



5. Click the Sorting and Grouping tab to define how to sort the information on the report.  See 
Diagram D. 

 To add groups to the report, select the fields by which to sort the information on the report by 
double-clicking on the desired fields in the list on the left side of the screen.  As the groups are 
added to the report, the groups will appear in the Report Layout List on the right side of the 
screen as Group_##, with ## reflecting the number of the group.  For example, the first group 
will be called Group_01, the second group will be called Group_02, the third group will be 
Group_03, etc. 
Note:  To remove a group from the report, click the Delete button located to the left of the 
desired group (Group_##); when prompted to delete the line, click Yes. 
Tip:  For each field added as a group on the report, a report parameter will also automatically 
be added for that same field (this is only applicable for reports created using the Report Wizard 
option). 

 The order the groups are listed on the screen in the Report Layout List is the order the groups 
will print (sort) the information on the actual report.  If desired, to change the order of the 
groups, click once on the group to move and then click the Top, Up, Down, or Bottom button 
until the group is in the desired position. 

 Define the settings for each Group section as follows: 

 The Group_## appears in the Section Name field and cannot be changed. 

 The field for which the group is defined appears in the Group By field and cannot be 
changed. 

 Enter the desired option for printing the Group Header section (Hide Section, Display 
Section with No Labels, Display Section with Page Labels, or Display Section with 
Section Labels) for the particular group in the Header Properties field, or click the down-
arrow button to select the correct one.  To not print the Group Header section for the 
particular group, enter Hide Section.  To print the fields in the Group Header section 
without printing any headings (labels) for the fields, enter Display Section with No 
Labels.  To print the fields in the Group Header section and the headings (labels) for the 
fields in the Page Header section as column headings, enter Display Section with Page 
Labels.  To print the fields and headings (labels) for the fields in the Group Header section 
in order to have the heading (label) print right before (to the left of) the field, enter Display 
Section with Section Labels.  The default of Display Section with Section Labels will 
appear, but can be changed. 

 Enter the desired option for printing the Group Footer section (Hide Section, Display 
Section with No Labels, Display Section with Page Labels, or Display Section with 
Section Labels) for the particular group in the Footer Properties field, or click the down-
arrow button to select the correct one.  To not print the Group Footer section for the 
particular group, enter Hide Section.  To print the fields in the Group Footer section without 
printing any headings (labels) for the fields, enter Display Section with No Labels.  To 
print the fields in the Group Footer section and the headings (labels) for the fields in the 
Page Header section as column headings, enter Display Section with Page Labels.  To 
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Diagram D 

Click the Sorting and Grouping tab 
to add groups to the new report. 

In this example, a group was added on 
the Vendor ID with the group header and 
footer defined as hidden (will not print). 



print the fields and headings (labels) for the fields in the Group Footer section in order to 
have the heading (label) print right before (to the left of) the field, enter Display Section 
with Section Labels.  The default of Display Section with Section Labels will appear, but 
can be changed. 

 Select the New Page After field to insert a page break (start a new page) after the Group 
Footer section for the particular group when printing the report.  A checkmark will appear in 
the box if the field is selected. 

 If desired, click the plus sign (+) in the box in front of the group (Group_##) to expand the record 
and view the fields included in the section.  By default, the field for which the group is defined is 
included in the section.  For example, if a group was added for Fund Number, the Fund Number 
field (and Fund Description field) will appear in the Group section. 

 To add fields to the group, click the Field Selection tab, click once on the group (Group_##) for 
which to add the fields, and then select the fields of information to include in the Group section 
by double-clicking on the desired fields in the list on the left side of the screen.  As the fields are 
added, the fields will appear under the Group section in the Report Layout List on the right side 
of the screen. 
Note:  To remove a field, click the Delete button located to the left of the desired field; when 
prompted to delete the line, click Yes. 

 Define the settings for each field included in the Group section as follows: 

 Enter the heading description to print for the field in the Label field, or leave the field blank 
to omit the heading, if desired.  The description can be alphanumeric and up to 128 
characters long.  A default heading description for the field will appear, but can be changed. 

 Enter the number of characters for how wide to print the field in the Field Width field.  The 
number for the width can be up to 3 digits long.  A default width for the field will appear, but 
can be changed. 

 The name of the field to print in the Group section appears in the Field Name field and 
cannot be changed. 

 Select the Display in Section Header field to include the field in the Group Header section 
for the particular group when printing the report.  A checkmark will appear in the box if the 
field is selected. 

 Select the Display in Section Footer field to include the field in the Group Footer section for 
the particular group when printing the report.  A checkmark will appear in the box if the field 
is selected. 

6. Click the Save button. 
7. If desired, click the Execute button to generate the report at this time. 
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Crosstab Reports 
 

Crosstab reports are reports that print in a grid format.  For example, the Balance Sheet - Combined 
report is a crosstab report, as the balance sheet accounts print in rows and the funds print in columns, 
with the ending balance printing as the detail information. 
 
In order to set up a custom report in Report Writer as a crosstab report, when first creating the report, 
the Report Type must be specified as Crosstab (an existing report cannot be changed to a crosstab 
report).  
 
Adding a Report: 
1. From the Report Writer screen, select the report group (query or view group) for which to add the 

new custom report by clicking on the name of the view group in the Report Groups List. 
Tip:  If desired, click the Directory button after clicking on a report group to view a list of the files 
from which fields can be included on a report in the particular report group. 

2. Click the New Record button located at the top of the screen to create a new report in the selected 
report group. 

3. Complete the report settings for the new report, being sure to select Crosstab as the Report Type.  
See Page 9-a for further details. 

4. Define the categories/screens for the new report.  See Page 10-a for further details. 
5. The Edit Report screen will appear for the report, showing the Page Header, Detail, and Page 

Footer sections.  See Diagram A. 
6. At the Edit Report screen, enter the information to be printed in the Page Header section, or 

suppress the Page Header section so that it does not print, if desired.  Insert special fields, database 
fields, labels, lines, shapes, or images into the Page Header section, as desired, and then resize, 
format, move, and align the items (objects) as needed. 
Note:  When creating a new report, the system automatically includes six standard header fields in 
the Page Header section, but the fields can be changed or deleted, if desired.  The six standard 
header fields include the system field from the database for the organization name and the special 
fields of Report Name, Page Number, Print Date, Sub Heading, and User ID. 
Tip:  If the standard header fields are not centered within the Page Header section, click the Adjust 
Header Fields button to align the standard header fields correctly within the Page Header section.  
If the Page Header section is not needed, suppress the section so that it does not print by first 
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Diagram A 

Click the fields for Column, Row, and Detail to 
select the fields to print as the columns, rows, 
and detail information on the crosstab report. 

To have a grand total print for each column on the crosstab report, add the Report 
Footer section to the report.  Once added, the Report Footer section cannot be 
edited, but will print a total for each column when the crosstab report is printed. 



clicking the title bar for the section and then selecting False in the Visible field under the Behavior 
section in the Properties List. 

7. In the Detail section, specify the database fields to print in the columns, rows, and as the detail 
information, by completing the following:  

 Click on the field (not the label) for Column in the Detail section; then in the Properties List 
(located in the lower right corner of the screen), click in the Data Field field under the Data 
section and click the down-arrow button to select the field to print as the columns. 

 Click on the field (not the label) for Row in the Detail section; then click in the Data Field field 
under the Data section in the Properties List and click the down-arrow button to select the field 
to print as the rows. 

 Click on the field (not the label) for Detail in the Detail section; then click in the Data Field field 
under the Data section in the Properties List and click the down-arrow button to select the field 
to print as the detail information (or values for the cells (the columns/rows)). 
Note:  The field selected for Detail (to print as the detail information on the report) must be a 
numeric field. 

8. Enter the information to be printed in the Page Footer section, or suppress the Page Footer section 
so that it does not print, if desired.  Insert database fields, formulas, labels, lines, shapes, images, 
subreports, or barcodes into the Page Footer section, as desired, and then resize, format, move, 
and align the items (objects) as needed. 
Note:  Initially, the height for the Page Footer section will be set to zero (0), and the section will 
need to be resized prior to inserting any objects into the section. 
Tip:  If the Page Footer section is not needed, leave the height set to zero (0) if there are no objects 
in the section, or else suppress the section so that it does not print by first clicking the title bar for the 
section and then selecting False in the Visible field under the Behavior section in the Properties List. 

9. To have a grand total print for each column, add the Report Footer section to the crosstab report.  
To add the Report Footer, select the Insert menu and then Report Header/Footer.  The Report 
Header and Report Footer sections will be included on the report.  The Report Footer section cannot 
be edited when working with a crosstab report, and nothing further has to be done to include the 
grand totals, as it will automatically include the grand total for each column when the crosstab report 
is printed. 
Tip:  If the Report Header section is not needed, suppress the section so that it does not print by 
first clicking the title bar for the section and then selecting False in the Visible field under the 
Behavior section in the Properties List. 
Note:  A total for each row will automatically print on the crosstab report (does not require any 
additional steps to be completed in order to have the row totals print on the crosstab report). 

10. If desired, add groups to the crosstab report, and then enter the information to be printed in the 
Group Header and Group Footer sections.  Insert database fields, formulas, labels, lines, shapes, 
images, subreports, or barcodes into the Group Header and Group Footer sections, as desired, and 
then resize, format, move, and align the items (objects) as needed.  Also, utilize the Properties 
List (located in the lower right corner of the screen) to change the defined properties for the Group 
Header and Group Footer sections, if desired.  See Page 11-a for further details on adding a group. 
Tip:  If the Group Header or Group Footer section is not needed, suppress the section so that it 
does not print by first clicking the title bar for the desired section and then selecting False in the 
Visible field under the Behavior section in the Properties List. 
Note:  A subtotal for each group will automatically print on the crosstab report in the Group Footer 
section (does not require any additional steps to be completed in order to have the group subtotals 
print on the crosstab report).   

11. If desired, add report parameters to the report.  See Page 14-a for further details. 
12. If desired, add a filter records formula to the report.  See Page 12-a for further details. 
13. If desired, add report selections to the report. 
14. Click the Save button. 
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Export Reports and Import Reports 
 
The Export Reports option is used to copy the setup of a custom report created in the Report Writer 
module to a file.  The Import Reports option is used to copy the setup of a custom report (saved to a file) 
into the Report Writer module.  The Export and Import Reports options allow organizations who have 
licensed the Report Writer module to share reports with other organizations who also have licensed the 
Report Writer module. 
 
Exporting Reports: 
1. From the Report Writer screen, select the Options menu and then Export Reports. 
2. At the Export Reports screen (see Diagram A), select the reports to export by clicking the box under 

the Selected column to the left of the report name.  A checkmark will appear in the box if the report 
is selected. 

3. Click the Execute button. 
4. At the Save As screen, specify the correct path (drive and folders) for the destination location and 

click the Save button.   
Note:  The name of the file will default to Transfer.xml; for easy retrieval when importing, do not 
change the name of this file. 

5. A message will appear in the status bar after the export is complete. 
6. Click the X in the upper right-hand corner of the screen to close the Export Reports screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
Importing Reports: 
1. From the Report Writer screen, select the Options menu and then Import Reports. 
2. At the Open screen, enter the correct path (drive and folders) and file name for the file containing 

the reports to import in the File Name field, and click the Open button. 
Note:  Typically, the name of the file will be Transfer.xml. 

3. At the Import Reports screen (see Diagram B), select the reports to import by clicking the box under 
the Selected column to the left of the report name.  A checkmark will appear in the box if the report 
is selected. 

4. Click the Execute button. 
5. When prompted, click Yes to continuing the import. 
6. If a report with the same name of the one being imported already exists, the system will prompt 

asking whether to replace, rename, or keep the report.  Click Replace to replace the existing report 
with the one being imported, click Rename to import the report using a new report name, or click 
Leave to keep the existing report (and not import the report with the same name). 

Diagram A 

Select the report(s) to export and 
then click the Execute button. 



7. A message will appear in the status bar after the import is complete. 
8. Click the X in the upper right-hand corner of the screen to close the Import Reports screen. 
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Diagram B 

Select the report(s) to import and 
then click the Execute button. 
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